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Abstract 

CDOT Noxious Weed Mapping Project 
July of 2000 to June of 2004 

Abstract 
 
The noxious weed mapping project started in July of 2000 as a cooperative effort between the Colorado 
Department of Transportation (CDOT) and the Colorado Natural Heritage Program (CNHP) to map weeds along 
rights-of-way maintained by CDOT.  The focus of the project was to produce accurate digital maps of weed 
infestations on CDOT managed lands using Global Positioning System (GPS) technology.  Below is a basic 
outline of the project. 

 
CNHP Tasks 
1. Developed methods and procedures tailored to GPS weeds mapping and other features in the field.   
2. Edited and transferred resulting digital files to a central location. 
3. Provided on-site seasonal training to CDOT employees as required. 
4. Provided technical assistance to CDOT staff on GPS mapping procedures and associated issues. 
5. Mapped weeds and other features in areas with reduced GPS orbital satellite availability. 
6. Coordinated with CDOT personnel to ensure that the appropriate areas were mapped. 
7. Edited and compiled newer GPS files into annually updated statewide digital map files that depict: 

o State maintained roads 
o Mile markers (significant mile markers along state maintained roads) 
o CDOT maintenance yards 
o First pass weeds (baseline maps of weed infestations on CDOT managed lands) 
o Second pass weeds (follow-up weed infestation maps, and updated species list) 

 
CDOT Tasks 
• Provided CDOT seasonal staff to field map a vast majority of the mapped features for the project. 
• Coordinated with CNHP and appropriate CDOT Maintenance Section personnel to ensure that 

appropriate areas were mapped. 
• Provided funding to CNHP from July of 2000 to June of 2004.  The project cost totaled $307,133. 

 
CNHP Products and Services Delivered 
• Trimble GeoExplorer 3 and Pathfinder Office Procedures Manual (Appendix A). 
• Colorado Noxious Weed Fact Sheets (a periodically updated weed identification guide for weeds on the 

official Colorado Noxious Weed List) (Appendix B). 
• GPS data dictionaries used for the mapping project, with required updates. 
• Seasonal training for CDOT field personnel (3-10 on-site training sessions per year). 
• Continuous technical assistance to CDOT employees on GPS mapping procedures, GPS file transfer 

protocols, weed identification, etc. 
• Coordinated with CDOT’s statewide coordinator to schedule mapping efforts. 
• Annually updated digital map files.  June, 2004 versions include the following digital map files: 

o State Maintained Roads: 22,900.21 miles mapped. 
o Mile markers: 22,791 mapped. 
o CDOT Maintenance Yards: 195 mapped. 
o First Pass Weeds: 19,241 separate weed infestations mapped totaling 5,432.41 acres. 
o Second Pass Weeds: 10,562 separate weed infestations mapped totaling 2,851.57 acres.  



Project Description 

CDOT Noxious Weed Mapping Project 
July of 2000 to June of 2004 

 
Introduction 
 
In July 1999, Governor Bill Owens signed an Executive Order requiring state agencies to develop and implement 
noxious weed management programs.  In July 2000, CDOT contracted the Colorado Natural Heritage Program 
(CNHP) to assist in creating a spatial inventory of noxious weeds within CDOT right-of-ways (in accordance with 
the CDOT Integrated Noxious Weed Management Plan).  The data collected was to be used as a management tool 
for roadside management of noxious weeds.   
 
CNHP was to provide training and technical support for CDOT personnel to map noxious weeds using Global 
Positioning System (GPS) technology, and to deliver integrated GIS datasets of GPS collected data to the CDOT 
GIS department who will make this data available to CDOT personnel and outside agencies.  This report will 
briefly discuss: 

• Development of CDOT’s GPS Weed Mapping Procedures  
• What was Mapped and Why 
• Training and Other Support Services Provided 
• Statewide Mapping Results 
• Mapping Results by Maintenance Section 

 
 
Development of CDOT Weed GPS Mapping Procedures 
 
CNHP developed procedures for mapping weeds and other features that were tailored to the Trimble GeoExplorer 
3 device and associated Pathfinder Office versions 2.51 and 2.80 computer software.  This involved: 

• Creating and updating data dictionaries that control what information is collected on the GPS devices 
(latest versions available from Cindy Stallman at email: Cindy.Stallman@dot.state.co.us ). 

• Documenting proven methods for using the GPS devices in the field, and procedures for retrieving and 
editing GPS files created in the field onto a desktop computer (Appendix A). 

• Producing and updating field ready weed identification fact sheets (Appendix B). 
 
 

What was Mapped and Why 
 
Early in the development process, it became clear that existing CDOT digital road and property maps were 
generated at too coarse a scale to be used effectively with GPS generated files.  GPS files are accurate to within 
one meter, while older digital road maps were generated from older paper maps (standard USGS 1:100,000 
topographic maps) that depicted large geographic areas, often with out-of-date information as well.  The disparity 
between the two map types made it very difficult to find GPS mapped areas without a GPS device in-hand.  To 
remedy this situation, CDOT and CNHP jointly decided to incorporate the mapping of CDOT managed roads, 
mile markers, and maintenance yards into the project as well.  In order to avoid confusion, and to assure map 
quality and non-duplication of efforts, features (map layers) were mapped in the following order: 

1. CDOT maintained roads, ramps, and frontage roads. 
2. Pertinent mile markers along all CDOT maintained roads. 
3. Maintenance yards. 



Project Description 

4. First pass weeds: to be used as a baseline map for weed infestation levels, and provide known weed 
infestation locations along CDOT rights-of-way.  This only included weeds on the Colorado Noxious 
Weed List from 2000 to 2002 (Appendix C). 

5. Second pass weeds: to be used as a follow-up to help track changes since the baseline weed maps were 
generated.  This also included changes made in the Colorado Noxious Weed List in 2003 (Appendix C).  

 
CNHP combined/edited all incoming GPS files into individual statewide digital GIS map files for each of the map 
layers described above.  This involved visually checking each GPS mapped feature to assure that the newly 
mapped features: 

• Either delineated unmapped CDOT roads and/or maintenance yards, or were associated with previously 
mapped roads and/or maintenance yards. 

• Passed visual inspection for geographic and data accuracy as described in Appendix A. 
• Did not duplicate previous mapping efforts. 
• Were combined into the statewide digital map files. 

 
Updated statewide digital map files were further manipulated by CNHP staff to adhere to agreed upon data 
standards (Appendix D).   GIS data files that met this standard were provided annually to the CDOT GIS office to 
incorporate into the CDOT system-wide mapping software.   
 
 
Training and Other Support Services Provided 
 
Training and technical support for CDOT employees was provided by CNHP on an ongoing basis.  This included: 

• On-site GPS unit and Pathfinder Office software training to CDOT employees at field maintenance 
offices, Maintenance and Operations offices at Camp George West, and other locations.  The number of 
training sessions included: 

o Ten separate training sessions in 2000 
o Five training sessions in 2001 
o Four training sessions per year in 2002 and 2003 
o Two training sessions during 2004 

• Seasonal written progress reports with printable maps to aid in coordinating mapping efforts.   
• Continuous written and oral communication with CDOT’s statewide weed coordinator to help coordinate 

statewide mapping efforts. 
• On-demand support to CDOT employees for the following software and hardware: 

o Trimble GeoExplorer 3 software and hardware 
o Pathfinder Office software 
o GIS software to CDOT weed mapping personnel as required 
o File transfer protocols and other software support critical to the project 

• Updating all GPS/GIS software, procedure manuals, and data dictionaries, etc. as required. 



Statewide Results 

Statewide Weed Mapping Results 
GPS Noxious Weed Mapping - September of 2000 to June of 2004 

Roads 
• 22,900.21 miles of roads were mapped for the entire state (Table 1). 
• 5,416 separate GPS map files were generated by CDOT and CNHP employees.   
• CNHP staff helped to coordinate with CDOT employees to map all Colorado roads, and edited/compiled 

all 5,416 separate GPS map files into the statewide road GIS map file.   
 
Table 1: Statewide mapping status, number of separate GPS map files generated, and miles of roads 
mapped by Maintenance Section. 

Section 
Mapping 

Status 

Number 
Separate GPS 

Map Files 
Generated 

Number 
Miles 

1 Complete1 1,014 4,960.22 
2 Complete1 849 3,044.92 
3 Complete1 240 1,553.93 
4 Complete1 1,372 5,037.20 
5 Complete1 780 3,312.61 
6 Complete1 72 1,607.89 
7 Complete1 156 1,419.68 
8 Complete1 933 1,963.77 
  Total 5,416 22,900.21 

1 Some frontage roads and areas subject to current/pending alteration will require future consideration. 
 
 
Mile Markers 

• 22,791 mile markers were mapped for the entire state by CDOT and CNHP employees (Table 2). 
• CNHP staff helped to coordinate with CDOT employees to map all significant mile markers in Colorado, 

and edited/compiled all 22,791mile markers into the statewide mile marker GIS map file. 
 

Table 2: Statewide mapping status and number of mile markers mapped by Maintenance Section. 

Section 
Mapping 

Status 
Number Mile 

Markers 
1 Complete1 4,999 
2 Complete1 3,668 
3 Complete1 1,620 
4 Complete1 4,250 
5 Complete1 3,304 
6 Complete1 1,708 
7 Complete1 1,584 
8 Complete1 1,658 
  Total 22,791 

1 Some frontage roads and areas subject to current/pending alteration will require future consideration. 
 



Statewide Results 

Maintenance Yards 
• 195 maintenance yards were mapped for the entire state by CDOT and CNHP employees for a total of 

679.56 acres (Table 3). 
• CNHP staff helped to coordinate with CDOT employees to map maintenance yards in Colorado, and 

edited/compiled all 195 maintenance yards into the statewide maintenance yard GIS map file. 
 

Table 3: Statewide mapping status and number of maintenance yards mapped by Maintenance Section. 

Section Status 

Number 
Maintenance 

Yards  Acres 
1 Complete2 38 132.67 
2 Complete2 43 201.38 
3 Complete2 22 78.30 
4 Incomplete3 0 0.00 
5 Complete2 39 92.01 
6 Complete2 16 52.10 
7 Complete2 20 75.02 
8 Complete2 17 48.08 
  Total 195 679.56 

2 Some maintenance yards and areas subject to current/pending alteration will require future consideration. 
3 No maintenance yards mapped to date. 
 

 
First Pass Weeds 

• 19,241 separately mapped first pass weed infestations were mapped in Colorado by CDOT and CNHP 
employees for a total of 5,432.41 acres (Table 4). 

• CNHP staff helped to coordinate with CDOT employees to map first pass weeds in Colorado, and 
edited/compiled all 19,241 separately mapped weed infestations into the statewide first pass weed GIS 
map file. 

 
Table 4: Statewide mapping status, number of separate GPS mapped weed infestations, and total 
numbers of acres of first pass weeds by Maintenance Section. 

Section 
First Pass 

Weed Status 

Number 
Separate GPS 

Mapped 
Infestations Acres 

1 Complete 5,869 1,054.81 

2 Complete 5,737 1,637.71 

3 Complete 575 403.12 

4 Incomplete4 1,936 720.76 

5 Complete 2,932 866.66 

6 Complete 1,634 352.47 

7 Complete 84 261.08 

8 Complete 474 135.80 
  Total 19,241 5,432.41 

4 Section 4 mapping began in April 2004 with approximately 1/3 complete to date. 



Statewide Results 

Second Pass Weeds 
• 10,562 separately mapped second pass weed infestations were mapped in Colorado by CDOT and CNHP 

employees for a total of 2,851.57 acres (Table 5).  Note: For Second Pass weed mapping, a minimum of 25% of each 
section is mapped seasonally by CDOT.    

• CNHP staff helped to coordinate with CDOT employees to map second pass weeds in Colorado, and 
edited/compiled all 10,562 separately mapped weed infestations into the statewide second pass weed GIS 
map file. 

 
Table 5: Statewide mapping status, number of separate GPS mapped weed infestations, and total 
numbers of acres for the second pass weeds by Maintenance Section. 

Section 
Second Pass 
Weed Status 

Number 
Separate GPS 

Mapped 
Infestations Acres 

1 Begun5 3,100 903.36 

2 Begun5 6,955 1,395.78 

3 None to Date 0 0.00 

4 Begun5 189 26.67 

5 None to Date 0 0.00 

6 None to Date 0 0.00 

7 Begun5 318 525.76 

8 None to Date 0 0.00 
  Total 10,562 2,851.57 

5 Second pass weed mapping began in 2003, and is scheduled for completion in 2007. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Maintenance Section 1 Results 

CDOT Maintenance Section 1 
GPS Noxious Weed Mapping - September of 2000 to June of 2004 

 
Section 1 Roads 

• 4,960.22 miles of road were mapped for Maintenance Section 1 (Table S1-1). 
• 1,014 separate GPS map files were generated by Maintenance Section 1 employees.   
• CNHP staff helped to coordinate with CDOT employees to map all roads in Maintenance Section 1 and 

edited/compiled all 1,014 separate GPS map files from Maintenance Section 1 into the statewide road GIS 
map file.   

 
Table S1-1: Number of miles and separate GPS map files generated by Route for Maintenance Section 1. 

Route Miles 

Number 
Separate GPS 

Map Files 
Generated  Route Miles 

Number 
Separate GPS 

Map Files 
Generated 

001A 19.96 2  066A 3.08 4 
006I 5.21 2  066B 45.74 6 
006J 201.45 24  068A 18.79 4 
006Z 1.82 2  071D 72.73 2 
007A 67.10 4  071E 52.11 4 
007B 8.30 4  071F 54.62 2 
007C 17.75 4  072B 43.23 2 
007E 2.95 2  076A 771.04 250 
011A 2.72 2  076B 1.01 2 
014B 123.06 10  079A 9.90 2 
014C 226.69 28  085C 254.21 54 
023A 35.03 2  085E 0.98 2 
025A 494.02 156  085F 5.45 6 
034A 265.81 74  085G 3.98 4 
034B 204.79 20  085H 7.58 8 
034C 3.31 2  093A 14.21 4 
034D 32.83 14  113A 37.60 2 
034E 1.77 4  119A 37.74 10 
034Z 2.37 2  119B 41.98 6 
036A 2.92 4  119C 26.01 8 
036B 133.06 78  138A 124.31 14 
036D 178.83 8  138Z 1.12 2 
036E 0.72 2  144A 57.29 4 
036Z 0.56 2  157A 21.70 26 
037A 13.67 2  170A 13.54 2 
039A 15.14 2  256A 6.27 2 
042A 9.71 2  257A 38.72 8 
052A 144.58 10  257B 2.35 2 
052B 52.06 10  25A 0.38 2 
055A 11.23 2  263A 12.13 2 
056A 6.18 2  287C 169.36 30 
056B 10.04 2  287Z 3.50 2 
059B 13.95 2  385C 19.39 6 



Maintenance Section 1 Results 

Route Miles 

Number 
Separate GPS 

Map Files 
Generated  Route Miles 

Number 
Separate GPS 

Map Files 
Generated 

059C 197.22 6  385D 183.96 12 
060A 9.88 2  385E 7.92 2 
060B 28.81 4  392A 9.25 2 
061A 83.27 4  392B 36.46 4 
063A 113.10 6  402A 8.69 2 

 
 
Section 1 Mile Markers 

• 4,999 mile markers were mapped by CDOT employees in Maintenance Section 1. 
• CNHP staff helped to coordinate with CDOT employees to map all pertinent mile markers in 

Maintenance Section 1, and edited/compiled all 4,999 mile marker positions from Maintenance Section 1 
into the statewide mile marker GIS map file (Table S1-2). 

 
Table S1-2: Number of GPS mapped mile markers by Route for Maintenance Section 1. 

Route 

Number of 
Mile 

Markers  Route 

Number of 
Mile 

Markers 

 

Route 

Number of 
Mile 

Markers 
001A 22  052B 58  113A 40 
006I 10  055A 12  119A 26 
006J 238  056A 8  119B 46 
007A 70  056B 14  119C 32 
007B 10  059B 18  138A 130 
007C 22  059C 208  138Z 4 
007E 6  060A 12  144A 62 
011A 6  060B 34  157A 24 
014B 126  061A 86  170A 16 
014C 230  063A 118  256A 10 
023A 38  066A 6  257A 36 
025A 300  066B 52  263A 16 
034A 289  068A 12  287C 180 
034B 216  071D 74  287Z 6 
034C 6  071E 60  385C 24 
034D 46  071F 58  385D 194 
034Z 6  072B 48  385E 12 
036A 6  076A 652  392A 48 
036B 130  076B 4  392B 66 
036D 180  079A 14  402A 12 
036E 4  085C 258  113A 40 
036Z 4  085E 4  119A 26 
037A 16  085F 12  119B 46 
039A 16  085H 10  119C 32 
042A 12  093A 18  138A 130 
052A 156       

 



Maintenance Section 1 Results 

 
Section 1 Maintenance Yards  

• 38 maintenance yards with a total of 132.67 acres were mapped by CDOT employees in Maintenance 
Section 1.  

• CNHP staff helped to coordinate with CDOT employees to map Maintenance Section 1 maintenance 
yards, and edited/compiled all 38 maintenance yards from Maintenance Section 1 into the statewide 
maintenance yard GIS map file (Table S1-3). 

 
Table S1-3: Name and acreage for each GPS mapped maintenance yard in Maintenance Section 1. 
Maintenance Yard Name Acres  Maintenance Yard Name Acres 
Akron 2.25  Livermore 2.80 
Anton 5.74  Longmont 2.59 
Ault 0.46  Loveland 5.57 
Brush 2.51  Mead 2.87 
Crook 1.28  Nederland 4.55 
Drake 0.74  New Raymer 4.49 
East Greeley 13.31  Nunn 0.46 
Estes Park 0.72  Old New Raymer Shop 0.34 
Fort Collins 2.54  Old Stoneham Shop 0.87 
Fort Lupton 4.61  Pierce 3.20 
Ft. Collins 3.13  Poudre Canyon 2.87 
Ft. Morgan 2.64  Sterling East Yard 6.11 
Gillcrest 0.83  Sterling Rest Area 8.84 
Haxtun 0.37  Sterling West Yard 6.10 
Holyoke 1.80  Superior 2.07 
J0Es  2.98  Wellington 0.59 
Johnstown 0.85  West Yard 9.11 
Julesburg 3.93  Wiggins 1.14 
Julesburg Rest Area 14.43  Yuma 2.96 

 
 
Section 1 First Pass Weeds 

• 5,869 separate weed infested areas totaling 1,054.81 acres were mapped by CDOT employees in 
Maintenance Section 1. 

• CNHP staff helped to coordinate with CDOT employees to map all weed infestations on lands 
maintained/controlled by Maintenance Section 1, and edited/compiled all 5,869 separate weed infested 
area segments from Maintenance Section 1 into the statewide first pass weed GIS map files (Figure S1-1, 
Tables S1-4 and S1-5). 

 
Table S1-4: Number of first pass mapped weed infestations and acres by primary weed species for Maintenance 
Section 1. 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 2492 498.78 
Dalmatian Toadflax 151 7.20 
Diffuse Knapweed 99 10.24 



Maintenance Section 1 Results 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Field Bindweed 2388 441.26 
Hoary Cress 56 6.89 
Jointed Goatgrass 2 0.51 
Leafy Spurge 67 9.85 
Musk Thistle 544 71.89 
Perennial Pepperweed 42 5.49 
Russian Knapweed 11 2.18 
Yellow Toadflax 17 0.52 
Total 5869 1054.81 

 
 

Figure S1-1: First Pass Weed Acres
(Primary Weed Species)
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Table S1-5: Number of first pass mapped infestations and acres by minor weed species, when more than one 
weed species was found, for Maintenance Section 1. 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 196 60.37 
Dalmatian Toadflax 6 1.03 
Diffuse Knapweed 4 0.34 
Field Bindweed 112 37.03 



Maintenance Section 1 Results 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Hoary Cress 10 1.50 
Leafy Spurge 1 0.51 
Musk Thistle 49 25.74 
Perennial Pepperweed 12 2.25 
Yellow Toadflax 3 0.56 
Total 393 129.33 

 
 
Section 1 Second Pass Weeds 

• 3,100 separate weed infested areas totaling 903.38 acres were mapped by CDOT employees in 
Maintenance Section 1.  Note: For Second Pass weed mapping, a minimum of 25% of each section is mapped seasonally by 
CDOT.    

• CNHP staff helped to coordinate with CDOT employees to begin mapping the second pass weed 
infestations on lands controlled by Maintenance Section 1, and edited/compiled all 3,100 separate weed 
infested area segments from Maintenance Section 1 into the statewide second pass weed GIS map files 
(Figure S1-2, Tables S1-6 and S1-7). 

 

Figure S1-2: Second Pass Weed Acres
(Primary Weed Species)
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Maintenance Section 1 Results 

Table S1-6: Number of second pass mapped weed infestations and acres by primary weed species for 
Maintenance Section 1. 

Second Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 628 102.65 
Dalmatian Toadflax 209 105.54 
Diffuse Knapweed 2 0.11 
Field Bindweed 1888 578.19 
Hoary Cress 11 4.20 
Leafy Spurge 69 42.06 
Musk Thistle 257 53.83 
Russian-Olive 34 16.75 
Saltcedar 2 0.05 
Total 3100 903.38 

 
Table S1-7: Number of second pass mapped weed infestations and acres by minor weed species for Maintenance 
Section 1. 

Second Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 147 75.46 
Dalmatian Toadflax 12 12.15 
Field Bindweed 61 37.69 
Hoary Cress 5 3.83 
Leafy Spurge 43 42.63 
Musk Thistle 73 76.61 
Russian-Olive 11 5.73 
Saltcedar 1 0.23 
Total 353 254.33 



Maintenance Section 2 Results 

CDOT Maintenance Section 2 
GPS Noxious Weed Mapping - September of 2000 to June of 2004 

 
Section 2 Roads 

• 3,044.92 miles of road were mapped for Maintenance Section 2 (Table S2-1). 
• 843 separate GPS map files were generated by Maintenance Section 2 employees.  
• CNHP staff helped to coordinate with CDOT employees to map all roads in Maintenance Section 2 and 

edited/compiled all 843 separate GPS map files from Maintenance Section 2 into the statewide road GIS 
map file.   

 
Table S2-1: Number of miles and separate GPS map files by Route for Maintenance Section 2. 

Route Miles 

Number 
Separate GPS 

Map Files 
Generated  Route Miles 

Number 
Separate GPS 

Map Files 
Generated 

006A 9.02 4  091A 43.71 4 
006B 17.64 20  092A 134.16 12 
006C 17.90 6  114A 37.81 2 
006D 37.52 2  131A 0.63 2 
006E 46.40 10  131B 42.81 2 
006L 5.39 2  133A 129.44 18 
013A 5.16 8  135A 55.84 8 
024A 97.34 14  139A 78.42 2 
050A 347.00 54  141A 116.51 12 
050D 2.93 2  141B 15.00 6 
065A 124.04 6  149A 150.26 4 
070A 1043.09 476  187A 2.11 4 
070B 66.24 50  300A 6.15 2 
070E 0.96 4  330A 22.85 2 
070F 0.69 2  340A 30.27 10 
070H 1.15 2  347A 10.31 2 
082A 254.50 44  348A 33.56 4 
082B 5.80 2  550B 34.68 39 
090B 17.62 6     

 
Section 2 Mile Markers 

• 3,668 mile markers were mapped by CDOT employees in Maintenance Section 2. 
• CNHP staff helped to coordinate with CDOT employees to map all pertinent mile markers in 

Maintenance Section 2, and edited/compiled all 3,668 mile marker positions from Maintenance Section 2 
into the statewide mile marker GIS map file (Table S2-2). 

 
Table S2-2: Number of GPS mapped mile markers by Route for Maintenance Section 2.  

Route 

Number of 
Mile 

Markers  Route 

Number of 
Mile 

Markers 

 

Route 

Number of 
Mile 

Markers 
006A 34  070E 4  135A 60 
006B 20  070F 4  139A 82 
006C 30  070H 4  141A 126 



Maintenance Section 2 Results 

Route 

Number of 
Mile 

Markers  Route 

Number of 
Mile 

Markers 

 

Route 

Number of 
Mile 

Markers 
006D 42  082A 288  141B 30 
006E 82  082B 4  149A 158 
006L 10  090B 16  187A 4 
013A 12  091A 52  300A 10 
024A 118  092A 150  330A 26 
050A 326  114A 40  340A 28 
065A 132  131A 4  347A 14 
070A 1386  131B 46  348A 34 
070B 106  133A 162  550B 24 
006A 34       

 
 
Section 2 Maintenance Yards  

• 43 maintenance yards for a total of 201.38 acres were mapped by CDOT employees in Maintenance 
Section 2. 

• CNHP staff helped to coordinate with CDOT employees to map Maintenance Section 2 maintenance 
yards, and edited/compiled all 43 maintenance yards from Maintenance Section 2 into the statewide 
maintenance yard GIS map file (Table S2-3). 

 
Table S2-3: Name and acreage for each GPS mapped maintenance yard in Maintenance Section 2. 
Maintenance Yard Name Acres  Maintenance Yard Name Acres 
3335 Sh 92 1.49  Leadville 1.75 
Aspen 0.69  Loma 8.60 
Bair Ranch Rest 1.91  Mesa 1.11 
Barn At Foot Of Mcclure 
Pass 1.78 

 
Montrose 9.96 

Blue Mesa Sand Shed 1.77  No Name Barn 0.12 
Blue Mesa Yd  3.93  No Name Rest 4.60 
Carbondale 2.02  Orchard Mesa Rest 0.80 
Clifton Rest Area 0.39  Paonia 3.10 
Colo Welcome Cntr 5.89  Parachute 3.69 
Debeque 6.70  Rgn Hq 4.46 
Delta 4.56  Rifle 1.35 
Dotsero 1.48  Rifle Rest Area 60.03 
Dowd Junction 7.52  Rifle Rest Area 13.78 
Escalante Rest 1.05  Rifle Rest Area 0.82 
Fruita Rest Area 0.27  Rifle Rest Area 0.93 
Fruituale Rest Area 0.35  Rifle Rest Area 0.17 
G Rd. Barn 6.11  Rifle Rest Area 6.47 
G21-006-01 7.70  Sand Shed 0.29 
Glenwood Yard 7.31  Twin Lakes 1.99 
Grizzly Creek Rest 3.09  Whitewater Yard 3.07 
Gypsum Yard 3.88  Wolcott Trailer Park 1.76 
Hanging Lake Rest 2.66    

 



Maintenance Section 2 Results 

 Section 2 First Pass Weeds 
• 5,737 separate weed infested areas totaling 1637.71 acres were mapped by CDOT employees in 

Maintenance Section 2. 
• CNHP staff helped to coordinate with CDOT employees to map all weed infestations on lands 

maintained/controlled by Maintenance Section 2, and edited/compiled all 5,737 separate weed infested 
area segments from Maintenance Section 2 into the statewide first pass weed GIS map files (Figure S2-1, 
Tables S2-4 and S2-5). 

 

Figure S2-1: First Pass Weed Acres
(Primary Weed Species)
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Table S2-4: Number of first pass mapped weed infestations and acres by primary weed species for Maintenance 
Section 2. 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 1750 374.49 
Dalmatian Toadflax 2 0.05 
Diffuse Knapweed 11 0.61 
Field Bindweed 331 112.71 
Hoary Cress 1236 332.55 
Houndstongue 73 10.87 
Jointed Goatgrass 353 219.24 
Leafy Spurge 3 0.69 
Musk Thistle 479 109.97 
Perennial Pepperweed 169 42.44 
Russian Knapweed 1294 427.28 



Maintenance Section 2 Results 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Spotted Knapweed 14 1.62 
Yellow Toadflax 22 5.19 
Total 5737 1637.71 

 
 
Table S2-5: Number of first pass mapped infestations and acres by minor weed species, when more than one 
weed species was found, for Maintenance Section 2. 

First Pass 
Minor Weed Species              

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 762 220.78 
Diffuse Knapweed 3 0.56 
Field Bindweed 802 225.63 
Hoary Cress 493 217.60 
Houndstongue 96 25.33 
Jointed Goatgrass 80 41.41 
Musk This tle 1277 354.10 
Perennial Pepperweed 39 11.80 
Russian Knapweed 495 235.05 
Spotted Knapweed 3 1.84 
Total 4050 1334.10 

 
 
Section 2 Second Pass Weeds 

• 6,955 separate weed infested areas totaling 1,395.78 acres were mapped by CDOT employees in 
Maintenance Section 2.  Note: For Second Pass weed mapping, a minimum of 25% of each section is mapped seasonally by 
CDOT.    

• CNHP staff helped to coordinate with CDOT employees to begin mapping the second pass weed 
infestations on lands controlled by Maintenance Section 2, and edited/compiled all 6,955 separate weed 
infested area segments from Maintenance Section 2 into the statewide second pass weed GIS map files 
(Figure S2-2, Tables S2-6 and S2-7). 



Maintenance Section 2 Results 

Figure S2-2: Second Pass Weed Acres
(Primary Weed Species)
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Table S2-6: Number of second pass mapped weed infestations and acres by primary weed species for 
Maintenance Section 2. 

Second Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Black Henbane 11 0.84 
Bull Thistle 19 1.75 
Canada Thistle 1800 313.52 
Chinese Cle matis  4 0.14 
Dalmatian Toadflax 7 0.22 
Dame'S Rocket 11 0.36 
Diffuse Knapweed 21 3.31 
Field Bindweed 1206 291.72 
Hoary Cress 308 49.18 
Houndstongue 53 6.38 
Jointed Goatgrass 31 7.22 



Maintenance Section 2 Results 

Second Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Leafy Spurge 7 0.39 
Musk Thistle 261 39.93 
Oxeye Daisy 89 14.88 
Perennial Pepperweed 23 3.62 
Plumeless Thistle 371 53.02 
Purple Loosestrife 28 4.03 
Russian Knapweed 1283 247.57 
Russian-Olive 305 54.33 
Saltcedar 884 279.82 
Scotch Thistle 140 13.33 
Spotted Knapweed 12 0.64 
Yellow Toadflax 81 9.58 
Total 6955 1395.78 

 
Table S2-7: Number of second pass mapped weed infestations and acres by minor weed species for Maintenance 
Section 2. 

Second Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate  GPS 

Mapped 
Infestations 

Total 
Acres 

Bull Thistle 11 1.17 
Canada Thistle 126 30.53 
Dalmatian Toadflax 2 0.39 
Field Bindweed 70 21.07 
Hoary Cress 54 18.47 
Houndstongue 12 2.60 
Jointed Goatgrass 1 0.11 
Leafy Spurge 3 1.02 
Musk Thistle 60 20.08 
Perennial Pepperweed 6 3.16 
Plumeless Thistle 46 7.67 
Purple Loosestrife 1 0.27 
Russian Knapweed 112 70.94 
Russian-Olive 78 53.06 
Saltcedar 67 32.80 
Scotch Thistle 9 2.22 
Yellow Toadflax 12 2.18 
Total 670 267.74 

 



Maintenance Section 3 Results 

CDOT Maintenance Section 3 
GPS Noxious Weed Mapping - September of 2000 to June of 2004 

 
Section 3 Roads 

• 1,553.93 miles of road were mapped for Maintenance Section 3 (Table S3-1). 
• 240 separate GPS map files were generated by Maintenance Section 3 employees. 
• CNHP staff helped to coordinate with CDOT employees to map all roads in Maintenance Section 3 and 

edited/compiled all 240 separate GPS map files from Maintenance Section 3 into the statewide road GIS 
map file.   

 
Table S3-1: Number of miles and separate GPS map files by Route for Maintenance Section 3. 

Route Miles 

Number 
Separate 
GPS Map 

Files 
Generated  Route Miles 

Number 
Separate 
GPS Map 

Files 
Generated 

003A 4.46 2  160A 351.81 58 
041A 19.04 2  160D 5.03 2 
062A 46.63 2  160E 4.84 2 
084A 56.39 6  160F 0.92 4 
090A 67.64 2  172A 49.01 2 
097A 9.10 2  184A 16.15 2 
110A 16.19 6  184B 34.87 2 
110B 3.90 2  550A 32.64 2 
140A 46.74 2  550B 195.85 104 
141A 192.19 16  666A 12.83 2 
145A 232.75 8  666B 87.21 8 
151A 67.74 2     

 
 
Section 3 Mile Markers 

• 1,620 mile markers were mapped by CDOT employees in Maintenance Section 3. 
• CNHP staff helped to coordinate with CDOT employees to map all pertinent mile markers in 

Maintenance Section 3, and edited/compiled all 1,620 mile -marker positions from Maintenance Section 3 
into the statewide mile -marker GIS map file (Table S3-2). 

 
Table S3-2: Number of GPS mapped mile-markers by Route for Maintenance Section 3.  

Route 

Number of 
Mile 

Markers  Route 

Number of 
Mile 

Markers 

 

Route 

Number of 
Mile 

Markers 
003A 4  140A 50  184A 20 
041A 22  141A 194  184B 40 
062A 50  145A 242  550A 36 
084A 58  151A 70  550B 204 
090A 70  160A 350  666A 16 
097A 12  160D 6  666B 96 
110A 18  160E 4    
110B 6  172A 52    



Maintenance Section 3 Results 

 
  
Section 3 Maintenance Yards  

• 22 maintenance yards were mapped by CDOT employees for a total of 78.30 acres in Maintenance 
Section 3. 

• CNHP staff helped to coordinate with CDOT employees to map Maintenance Section 3 maintenance 
yards, and edited/compiled all 22 maintenance yards from Maintenance Section 3 into the statewide 
maintenance yard GIS map file (Table S3-3). 

 
Table S3-3: Name and acreage for each GPS mapped maintenance yard in Maintenance Section 3. 
Maintenance Yard Name Acres  Maintenance Yard Name Acres 
Bayfield 0.73  Old Mancos 0.53 
Cascade 2.46  Ouray 3.04 
Cortez 5.19  Pagosa Springs 9.31 
Dolores 3.84  Paradox 0.73 
Dove Creek 0.74  Rico 2.64 
Durango 0.41  Ridgway 1.31 
Hesperus 4.38  Rockwood 3.23 
Ignacio 9.14  Silverton 0.70 
Mancos 3.68  Sleeping Ute Rest Area 12.70 
Norwood 1.54  Telluride 0.66 
Nucla 9.01  Wolf Creek 2.32 

  
Section 3 First Pass Weeds 

• 575 separate weed infested areas totaling 403.12 acres were mapped by CDOT employees in Maintenance 
Section 3. 

• CNHP staff helped to coordinate with CDOT employees to map all weed infestations on lands 
maintained/controlled by Maintenance Section 3, and edited/compiled all 575 separate weed infested area 
segments from Maintenance Section 3 into the statewide first pass weed GIS map files (Figure S3-1, 
Tables S3-4 and S3-5). 

 
Table S3-4: Number of first pass mapped weed infestations and acres by primary weed species for Maintenance 
Section 3. 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 270 187.48 
Dalmatian Toadflax 2 0.60 
Diffuse Knapweed 5 4.48 
Field Bindweed 26 17.60 
Hoary Cress 32 28.07 
Houndstongue 1 5.01 
Musk Thistle 59 49.89 
Perennial Pepperweed 3 1.56 
Russian Knapweed 157 98.15 
Spotted Knapweed 7 8.51 
Yellow Toadflax 13 1.77 
Total 575 403.12 



Maintenance Section 3 Results 

 

Figure S3-1: First Pass Weed Acres
(Primary Weed Species)
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Table S3-5: Number of first pass mapped infestations and acres by minor weed species, when more than one 
weed species was found, for Maintenance Section 3. 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 9 7.32 
Musk Thistle 11 8.96 
Diffuse Knapweed 1 1.33 
Field Bindweed 11 9.53 
Hoary Cress 3 5.96 
Russian Knapweed 4 13.31 
Yellow Toadflax 1 0.28 
Houndstongue 1 1.88 
Jointed Goatgrass 1 0.61 
Total 42 49.18 

 
 
Section 3 Second Pass Weeds 

• None mapped to date. 
 



Maintenance Section 4 Results 
CDOT Maintenance Section 4 

GPS Noxious Weed Mapping - September of 2000 to June of 2004 
 

Section 4 Roads 
• 5,037.20 miles of road were mapped for Maintenance Section 4 (Table S4-1). 
• 1,372 separate GPS map files were generated by Maintenance Section 4 employees. 
• CNHP staff helped to coordinate with CDOT employees to map all roads in Maintenance Section 4 and 

edited/compiled all 1,372 separate GPS map files from Maintenance Section 4 into the statewide road GIS 
map file.   

 
Table S4-1: Number of miles and separate GPS map files by Route for Maintenance Section 4. 

Route Miles 

Number 
Separate 
GPS Map 

Files 
Generated  Route Miles 

Number 
Separate 
GPS Map 

Files 
Generated 

009A 54.04 2  096A 130.91 14 
010A 143.38 4  096B 72.82 4 
012A 139.95 4  096C 120.09 4 
016A 2.18 5  096D 77.67 4 
024A 232.17 33  100A 0.84 2 
024E 3.90 3  101A 41.79 2 
024G 54.00 80  105A 18.85 2 
025A 958.50 714  109A 120.35 5 
025B 3.70 2  109B 9.36 2 
025C 7.50 2  115A 119.05 64 
025D 27.10 10  116A 64.52 4 
029A 8.31 6  120A 14.20 2 
038A 3.61 4  160A 46.27 4 
045A 39.36 20  160B 1.70 2 
047A 24.27 40  160C 306.57 10 
050A 230.82 30  165A 73.22 2 
050B 439.40 100  167A 9.82 6 
050C 53.27 6  194A 40.33 2 
050Z 5.14 2  196A 71.58 10 
067A 22.11 2  196B 0.44 2 
067B 7.38 2  202A 6.41 4 
067C 47.78 2  207A 11.82 2 
067D 46.05 2  209A 3.00 2 
069A 164.42 4  227A 7.62 14 
071A 17.99 2  231A 4.03 2 
071B 9.82 4  233A 4.15 2 
071C 64.91 2  239A 6.43 2 
078A 68.13 4  266A 22.90 2 
078B 2.99 4  287A 159.69 6 
083A 73.67 28  287B 100.57 20 
083B 2.68 4  350A 145.62 4 
085A 23.75 26  385A 55.60 2 
089A 68.71 2  385B 23.63 2 
094A 68.82 2  389A 25.55 4 



Maintenance Section 4 Results 

Section 4 Mile Markers 
• 4,250 mile markers were mapped by CDOT employees in Maintenance Section 4. 
• CNHP staff helped to coordinate with CDOT employees to map all pertinent mile markers in 

Maintenance Section 4, and edited/compiled all 4,250 mile marker positions from Maintenance Section 4 
into the statewide mile -marker GIS map file (Table S4-2). 

 
Table S4-2: Number of GPS mapped mile markers by Route for Maintenance Section 4.  

Route 

Number of 
Mile 

Markers  Route 

Number of 
Mile 

Markers 

 

Route 

Number of 
Mile 

Markers 
009A 56  071B 12  160C 314 
010A 148  071C 68  165A 74 
012A 146  078A 70  167A 12 
016A 3  078B 6  183A 2 
024A 126  083A 57  194A 42 
024E 5  085A 13  196A 72 
025A 515  089A 68  202A 10 
025B 6  094A 72  207A 14 
025C 10  096A 120  209A 9 
029A 6  096B 84  227A 3 
047A 20  096C 124  231A 3 
050A 238  096D 78  233A 4 
050B 328  101A 44  239A 10 
050C 18  105A 11  266A 24 
050Z 8  109A 123  287A 156 
067A 26  115A 90  287B 96 
067B 10  116A 66  350A 152 
067C 52  120A 18  385A 56 
067D 50  160A 52  385B 24 
069A 172  160B 6  389A 28 
071A 20       

 
  
Section 4 Maintenance Yards  

• None mapped to date. 
 
 Section 4 First Pass Weeds 

• 1,936 separate weed infested areas totaling 720.76 acres were mapped by CNHP employees in 
Maintenance Section 4. 

• CNHP staff mapped all weed infestations in Maintenance Section 4 to date, and edited/compiled all 1,936 
separate weed infested area segments from Maintenance Section 4 into the statewide first pass weed GIS 
map files (Figure S4-1, Tables S4-3 and S4-4). 



Maintenance Section 4 Results 

Figure S4-1: First Pass Weed Acres
(Primary Weed Species)
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Table S4-3: Number of first pass mapped weed infestations and acres by primary weed species for Maintenance 
Section 4. 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 42 4.11 
Dalmatian Toadflax 2 0.74 
Diffuse Knapweed 124 46.31 
Field Bindweed 1462 613.33 
Hoary Cress 150 28.42 
Houndstongue 2 0.26 
Jointed Goatgrass 7 1.43 
Musk Thistle 69 9.48 
Perennial Pepperweed 20 6.83 
Russian Knapweed 58 9.85 
Total 1936 720.76 

 
Table S4-4: Number of first pass mapped infestations and acres by minor weed species, when more than one 
weed species was found, for Maintenance Section 4. 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 22 5.22 
Dalmatian Toadflax 1 0.73 



Maintenance Section 4 Results 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Diffuse Knapweed 12 4.47 
Field Bindweed 111 27.75 
Hoary Cress 69 64.46 
Musk Thistle 13 3.25 
Perennial Pepperweed 4 4.88 
Russian Knapweed 16 23.67 
Spotted Knapweed 4 0.73 
Total 252 135.16 

 
 
Section 4 Second Pass Weeds 

• 186 separate weed infested areas totaling 26.67 acres were mapped by CNHP employees in Maintenance 
Section 4.  Note: For Second Pass weed mapping, a minimum of 25% of each section will be mapped seasonally by CDOT.    

• CNHP staff mapped all weed infestations in Maintenance Section 4 to date, and edited/compiled all 186 
separate weed infested area segments from Maintenance Section 4 into the statewide second pass weed 
GIS map files (Figure S4-2, Tables S4-5 and S4-6). 

Figure S4-2: Second Pass Weed Acres
(Primary Weed Species)
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Maintenance Section 4 Results 

Table S4-5: Number of second pass mapped weed infestations and acres by primary weed species for 
Maintenance Section 4. 

Second Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Bull Thistle 2 0.07 
Perennial Pepperweed 1 0.01 
Russian-Olive 12 2.18 
Saltcedar 45 4.18 
Scotch Thistle 126 20.23 
Total 186 26.67 

 
Table S4-6: Number of second pass mapped weed infestations and acres by minor weed species for Maintenance 
Section 4. 

Second Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 2 0.37 
Diffuse Knapweed 2 0.05 
Field Bindweed 42 8.78 
Hoary Cress 8 2.60 
Musk Thistle 1 0.46 
Russian Knapweed 1 0.50 
Russian-Olive 4 1.05 
Saltcedar 1 0.52 
Total 61 14.33 

 



Maintenance Section 5 Results 

CDOT Maintenance Section 5 
GPS Noxious Weed Mapping - September of 2000 to June of 2004 

 
Section 5 Roads 

• 3,312.61 miles of road were mapped for Maintenance Section 5 (Table S5-1). 
• 780 separate GPS map files were generated by Maintenance Section 5 employees. 
• CNHP staff helped to coordinate with CDOT employees to map all roads in Maintenance Section 5 and 

edited/compiled all 780 separate GPS map files from Maintenance Section 5 into the statewide road GIS 
map file.   

 
Table S5-1: Number of miles and separate GPS map files by Route for Maintenance Section 5. 

Route Miles 

Number 
Separate 
GPS Map 

Files 
Generated  Route Miles 

Number 
Separate 
GPS Map 

Files 
Generated 

005A 28.57 2  059B 81.07 2 
006F 47.47 14  067E 19.87 2 
006G 39.90 56  070A 1119.84 378 
009C 67.00 6  070L 0.59 2 
009D 57.17 4  070M 0.66 2 
018A 0.83 2  070O 0.49 2 
024B 35.51 2  070P 1.09 2 
024C 34.27 2  070Q 0.37 2 
024D 2.75 4  071C 104.07 4 
024F 0.61 2  071D 72.11 2 
024G 65.02 6  072A 37.35 2 
025A 159.73 146  074A 51.65 22 
025E 0.45 2  079A 38.34 2 
030A 17.97 8  083A 94.35 6 
036C 25.49 2  085B 34.50 6 
036D 82.17 6  086A 118.37 6 
040A 59.86 6  091A 0.83 2 
040C 8.94 6  094A 102.42 2 
040D 12.17 2  103A 44.88 2 
040E 15.82 2  105B 9.01 2 
040F 20.20 2  119A 45.45 2 
040H 202.92 10  279A 3.04 4 
046A 12.91 2  285D 151.36 16 
057A 2.01 2  385B 28.66 2 
059A 38.00 2  385C 114.48 8 

 
 
Section 5 Mile Markers 

• 3,304 mile markers were mapped by CDOT employees in Maintenance Section 5. 
• CNHP staff helped to coordinate with CDOT employees to map all pertinent mile markers in 

Maintenance Section 5, and edited/compiled all 3,304 mile marker positions from Maintenance Section 5 
into the statewide mile marker GIS map file (Table S5-2). 



Maintenance Section 5 Results 

 
Table S5-2: Number of GPS mapped mile markers by Route for Maintenance Section 5.  

Route 

Number of 
Mile 

Markers  Route 

Number of 
Mile 

Markers 

 

Route 

Number of 
Mile 

Markers 
005A 30  040D 16  079A 40 
006F 50  040E 20  083A 100 
006G 36  040F 24  085B 34 
009C 70  040H 210  086A 130 
009D 54  046A 16  091A 4 
024C 38  059A 40  094A 106 
024D 4  059B 82  103A 2 
024G 66  067E 24  105B 12 
025A 216  070A 1004  119A 46 
030A 22  070M 4  279A 6 
036C 30  071C 112  285D 158 
036D 88  071D 76  385B 32 
040A 68  072A 42  385C 122 
040B 18  074A 52    

  
Section 5 Maintenance Yards  

• 39 maintenance yards were mapped by CDOT employees for a total of 92.01 acres in Maintenance 
Section 5.  

• CNHP staff helped to coordinate with CDOT employees to map Maintenance Section 5 maintenance 
yards, and edited/compiled all 39 maintenance yards from Maintenance Section 5 into the statewide 
maintenance yard GIS map file (Table S5-3). 

 
Table S5-3: Name and acreage for each GPS mapped maintenance yard in Maintenance Section 5. 
Maintenance Yard Name Acres  Maintenance Yard Name Acres 
Abasin 0.68  Franktown 2.20 
Arriba 2.89  Frisco 0.93 
Arriba Rest Area 0.22  Hidden Valley 1.94 
Arriba Rest Area 0.87  Hugo 0.89 
Bailey 7.77  Kiowa 2.29 
Bennett Restarea 1.07  Kit Carson 0.44 
Bennett Restarea 3.00  Kittredge 1.58 
Berthoud Falls  0.98  Limon Maintenance 3.36 
Blackhawk 0.59  Matheson 0.52 
Boyero 3.99  Morrison 1.44 
Burlington Rest Area 4.00  Picnic Area 0.79 
Burlington Yard 2.74  Punkin Center 1.94 
Castle Rock 7.04  Sedalia 2.05 
Castle Rock 2.79  Silverthorne 4.31 
Cheyenne Wells  0.76  State Line 0.53 
Coal Creek 2.51  Vail Rest Area 5.05 
Deer Trail Restarea 7.34  Vail Sand Shed 0.84 
Deer Trail Restarea 3.37  Webster 0.76 
Empire Jct. 4.35  Winter Park 2.22 
Faiirplay 0.94    



Maintenance Section 5 Results 

Section 5 First Pass Weeds 
• 2,932 separate weed infested areas totaling 866.66 acres were mapped by CDOT employees in 

Maintenance Section 5. 
• CNHP staff helped to coordinate with CDOT employees to map all weed infestations on lands 

maintained/controlled by Maintenance Section 5, and edited/compiled all 2,932 separate weed infested 
area segments from Maintenance Section 5 into the statewide first pass weed GIS map files (Figure S5-1, 
Tables S5-4 and S5-5). 

Figure S5-1: First Pass Weed Acres
(Primary Weed Species)
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Table S5-4: Number of first pass mapped weed infestations and acres by primary weed species for Maintenance 
Section 5. 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 835 143.28 
Dalmatian Toadflax 7 1.12 
Diffuse Knapweed 423 340.94 
Field Bindweed 1357 286.61 
Hoary Cress 26 14.63 
Jointed Goatgrass 3 0.45 
Leafy Spurge 95 30.16 
Musk Thistle 147 38.89 
Russian Knapweed 32 8.09 
Spotted Knapweed 4 2.23 
Yellow Toadflax 3 0.28 
Total 2932 866.68 



Maintenance Section 5 Results 

 
Table S5-5: Number of first pass mapped infestations and acres by minor weed species, when more than one 
weed species was found, for Maintenance Section 5. 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 203 116.75 
Diffuse Knapweed 24 9.71 
Field Bindweed 124 68.76 
Leafy Spurge 2 1.29 
Musk Thistle 81 72.27 
Russian Knapweed 1 0.68 
Spotted Knapweed 7 22.33 
Total 442 291.79 

 
 
Section 5 Second Pass Weeds 

• None mapped to date. 
 Note: For Second Pass weed mapping, a minimum of 25% of each section is mapped seasonally by CDOT.   



Maintenance Section 6 Results 

CDOT Maintenance Section 6 
GPS Noxious Weed Mapping - September of 2000 to June of 2004 

 
Section 6 Roads 

• 1,607.84 miles of road were mapped for Maintenance Section 6 (Table S6-1). 
• 72 separate GPS map files were generated by Maintenance Section 6 employees.  
• CNHP staff helped to coordinate with CDOT employees to map all roads in Maintenance Section 6 and 

edited/compiled all 72 separate GPS map files from Maintenance Section 6 into the statewide road GIS 
map file.   

 
Table S6-1: Number of miles and separate GPS map files by Route for Maintenance Section 6. 

Route Miles 

Number 
Separate GPS 

Map Files 
Generated  Route Miles 

Number 
Separate GPS 

Map Files 
Generated 

009D 22.82 2  125A 150.56 4 
013A 178.07 8  127A 18.14 2 
013B 76.32 2  131B 94.00 4 
014A 65.60 2  134A 53.84 4 
014B 53.37 2  139A 65.07 2 
034A 29.84 2  317A 24.06 2 
040A 463.95 18  318A 121.03 2 
040F 1.79 2  325A 22.41 2 
040Z 2.26 6  394A 18.53 2 
064A 146.24 4     

 
 
Section 6 Mile Markers 

• 1,708 mile markers were mapped by CDOT employees in Maintenance Section 6. 
• CNHP staff helped to coordinate with CDOT employees to map all pertinent mile markers in 

Maintenance Section 6, and edited/compiled all 1,708 mile marker positions from Maintenance Section 6 
into the statewide mile marker GIS map file (Table S6-2). 

 
Table S6-2: Number of GPS mapped mile markers by Route for Maintenance Section 6.  

Route 

Number of 
Mile 

Markers  Route 

Number of 
Mile 

Markers 

 

Route 

Number of 
Mile 

Markers 
317 2  040A 484  134A 62 
009D 26  040F 4  139A 70 
013A 184  040Z 4  317A 26 
013B 80  064A 152  318A 124 
014A 68  125A 158  325A 26 
014B 58  127A 22  394A 22 
034A 34  131B 102    

 
  



Maintenance Section 6 Results 

Section 6 Maintenance Yards  
• 16 maintenance yards were mapped by CDOT employees for a total of 52.10 acres in Maintenance 

Section 6. 
• CNHP staff helped to coordinate with CDOT employees to map Maintenance Section 6 maintenance 

yards, and edited/compiled all 16 maintenance yards from Maintenance Section 6 into the statewide 
maintenance yard GIS map file (Table S6-3). 

 
Table S6-3: Name and acreage for each GPS mapped maintenance yard in Maintenance Section 6. 
Maintenance Yard Name Acres  Maintenance Yard Name Acres 
Craig East Yard 8.31  Muddy Pass 3.08 
Granby 1.36  Rabbit Ears 2.77 
Hayden 4.75  Rangely Yard 4.75 
Hot Sulphur 0.86  Rifle Yard 9.37 
Kremmling 2.12  Skull Creek Housing 2.20 
Mainshop 3.37  Skull Creek Yard 1.98 
Maybell Yard 1.11  Steamboat 1.08 
Meeker Yard 3.07  Yampa 1.92 

 
 
 Section 6 First Pass Weeds 

• 1,634 separate weed infested areas totaling 352.48 acres were mapped by CDOT employees in 
Maintenance Section 6. 

• CNHP staff helped to coordinate with CDOT employees to map all weed infestations on lands 
maintained/controlled by Maintenance Section 6, and edited/compiled all 1,634 separate weed infested 
area segments from Maintenance Section 6 into the statewide first pass weed GIS map files (Figure S6-1, 
Tables S6-4 and S6-5). 

 
Table S6-4: Number of first pass mapped weed infestations and acres by primary weed species for Maintenance 
Section 6. 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 614 137.19 
Dalmatian Toadflax 150 41.11 
Field Bindweed 83 11.44 
Hoary Cress 202 31.97 
Houndstongue 292 43.82 
Jointed Goatgrass 2 0.29 
Leafy Spurge 141 57.83 
Musk Thistle 27 4.35 
Perennial Pepperweed 36 8.13 
Russian Knapweed 46 6.64 
Yellow Toadflax 41 9.71 
Total 1634 352.48 

 



Maintenance Section 6 Results 

Figure S6-1: First Pass Weed Acres
(Primary Weed Species)
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Table S6-5: Number of first pass mapped infestations and acres by minor weed species, when more than one 
weed species was found, for Maintenance Section 6. 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 21 4.83 
Dalmatian Toadflax 12 1.98 
Field Bindweed 2 0.34 
Hoary Cress 16 6.64 
Houndstongue 34 10.41 
Leafy Spurge 1 1.36 
Musk Thistle 1 1.26 
Russian Knapweed 1 0.85 
Total 88 27.67 

 
 
Section 6 Second Pass Weeds 

• None mapped to date.  Note: For Second Pass weed mapping, a minimum of 25% of each section is mapped seasonally by 
CDOT.    

 



Maintenance Section 7 Results 

CDOT Maintenance Section 7 
GPS Noxious Weed Mapping - September of 2000 to June of 2004 

 
Section 7 Roads 

• 1,419.68 miles of road were mapped for Maintenance Section 7 (Table S7-1). 
• 156 separate GPS map files were generated by Maintenance Section 7 employees.  
• CNHP staff helped to coordinate with CDOT employees to map all roads in Maintenance Section 7 and 

edited/compiled all 156 separate GPS map files from Maintenance Section 7 into the statewide road GIS 
map file.   

 
Table S7-1: Number of miles and separate GPS map files by Route for Maintenance Section 7. 

Route Miles 

Number 
Separate GPS 

Map Files 
Generated  Route Miles 

Number 
Separate GPS 

Map Files 
Generated 

009B 71.64 4  150A 32.40 4 
015B 20.88 2  159A 67.32 2 
017A 77.90 4  160A 172.60 22 
017B 99.45 4  285A 72.12 8 
024A 125.08 18  285B 75.13 4 
050A 162.02 10  285C 42.60 40 
112A 30.25 4  285D 42.32 2 
114A 85.79 6  291A 18.01 6 
136A 8.91 2  368A 24.60 2 
142A 67.04 4  370A 28.23 2 
149A 83.31 4  371A 12.08 2 

 
 
Section 7 Mile Markers 

• 1,584 mile markers were mapped by CDOT employees in Maintenance Section 7. 
• CNHP staff helped to coordinate with CDOT employees to map all pertinent mile markers in 

Maintenance Section 7, and edited/compiled all 1,584 mile marker positions from Maintenance Section 7 
into the statewide mile marker GIS map file (Table S7-2). 

 
Table S7-2: Number of GPS mapped mile markers by Route for Maintenance Section 7.  

Route 

Number of 
Mile 

Markers  Route 

Number of 
Mile 

Markers 

 

Route 

Number of 
Mile 

Markers 
009A 42  114A 88  285B 134 
009B 36  136A 12  285C 50 
015B 24  142A 72  285D 46 
017A 82  149A 90  291A 22 
017B 106  150A 36  368A 28 
024A 136  159A 70  370A 32 
050A 164  160A 186  371A 16 
112A 36  285A 76    

 
  



Maintenance Section 7 Results 

Section 7 Maintenance Yards  
• 20 maintenance yards were mapped by CDOT employees for a total of 75.02 acres in Maintenance 

Section 7. 
• CNHP staff helped to coordinate with CDOT employees to map Maintenance Section 7 maintenance 

yards, and edited/compiled all 20 maintenance yards from Maintenance Section 7 into the statewide 
maintenance yard GIS map file (Table S7-3). 

 
Table S7-3: Name and acreage for each GPS mapped maintenance yard in Maintenance Section 7. 
Maintenance Yard Name Acres  Maintenance Yard Name Acres 
Alamosa Patrols  4.99  Maysville 2.91 
Antonito 0.63  Monarch Dome 0.53 
Antonito 1.01  Monte Vista 1.91 
Creed 0.57  Monte Vista Office 0.60 
Fairplay 8.74  Ponch Springs 8.68 
Fort Garland 1.06  Quonset Monte Vista 1.01 
Garfield 0.92  Saguache 2.53 
Hartsel 10.47  Shaw Creek 9.35 
Johnson Village 4.08  South Fork 3.90 
La Veta 6.09  Wolf Creek 5.06 

 
 
 Section 7 First Pass Weeds 

• 84 separate weed infested areas totaling 261.08 acres were mapped by CDOT employees in Maintenance 
Section 7. 

• CNHP staff helped to coordinate with CDOT employees to map all weed infestations on lands 
maintained/controlled by Maintenance Section 7, and edited/compiled all 84 separate weed infested area 
segments from Maintenance Section 7 into the statewide first pass weed GIS map files (Figure S7-1, 
Tables S7-4 and S7-5). 

 
Table S7-4: Number of first pass mapped weed infestations and acres by primary weed species for Maintenance 
Section 7. 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 47 88.53 
Dalmatian Toadflax 1 1.95 
Field Bindweed 10 23.34 
Hoary Cress 20 71.47 
Perennial Pepperweed 1 5.33 
Russian Knapweed 5 70.46 
Total 84 261.08 

 
 
 
 



Maintenance Section 7 Results 

Figure S7-1: First Pass Weed Acres
(Primary Weed Species)
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Table S7-5: Number of first pass mapped infestations and acres by minor weed species, when more than one 
weed species was found, for Maintenance Section 7. 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

None mapped 0 0 
Total 0 0 

 
 
Section 7 Second Pass Weeds 

• 318 separate weed infested areas totaling 525.75 acres were mapped by CDOT employees in Maintenance 
Section 7.  Note: For Second Pass weed mapping, a minimum of 25% of each section is mapped seasonally by CDOT.    

• CNHP staff he lped to coordinate with CDOT employees to begin mapping the second pass weed 
infestations on lands controlled by Maintenance Section 7, and edited/compiled all 318 separate weed 
infested area segments from Maintenance Section 7 into the statewide second pass weed GIS map files 
(Figure S7-2, Tables S7-6 and S7-7). 



Maintenance Section 7 Results 

Figure S7-2: Second Pass Weed Acres
(Primary Weed Species)
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Table S7-6: Number of second pass mapped weed infestations and acres by primary weed species for 
Maintenance Section 7. 

Second Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Bull Thistle 1 0.07 
Canada Thistle 163 136.37 
Dalmatian Toadflax 1 1.52 
Field Bindweed 28 67.95 
Hoary Cress 33 32.61 
Musk Thistle 2 0.24 
Oxeye Daisy 5 1.91 
Perennial Pepperweed 8 4.16 
Russian Knapweed 71 279.66 
Russian-Olive 1 0.54 
Spotted Knapweed 2 0.34 
Yellow Toadflax 3 0.38 
Total 318 525.75 

 



Maintenance Section 7 Results 

Table S7-7: Number of second pass mapped weed infestations and acres by minor weed species for Maintenance 
Section 7. 

Second Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Bull Thistle 1 0.70 
Hoary Cress 3 34.65 
Total 4 35.35 

 



Maintenance Section 8 Results 

CDOT Maintenance Section 8 
GPS Noxious Weed Mapping - September of 2000 to June of 2004 

 
Section 8 Roads 

• 1,963.77 miles of road were mapped for Maintenance Section 8 (Table S8-1). 
• 933 separate GPS map files were generated by Maintenance Section 8 employees.   
• CNHP staff helped to coordinate with CDOT employees to map all roads in Maintenance Section 8 and 

edited/compiled all 933 separate GPS map files from Maintenance Section 8 into the statewide road GIS 
map file.   

 
Table S8-1: Number of miles and separate GPS map files by Route for Maintenance Section 8. 

Route Miles 

Number 
Separate GPS 

Map Files 
Generated  Route Miles 

Number 
Separate GPS 

Map Files 
Generated 

002A 49.67 10  076A 140.67 64 
002B 10.11 4  083A 50.60 12 
002C 13.06 2  085B 42.71 8 
006G 95.50 90  085C 36.96 4 
006H 27.24 16  088A 60.35 18 
007D 43.45 10  088B 17.52 4 
008A 35.12 4  093A 50.50 4 
022A 4.94 2  095A 57.35 16 
025A 155.08 178  121A 104.89 16 
026A 8.64 4  121B 17.74 4 
030A 44.57 8  128A 31.91 4 
032A 2.73 2  128B 8.70 4 
035A 3.46 6  177A 25.11 4 
036B 49.91 40  224A 14.59 4 
040C 99.71 20  225A 58.74 48 
044A 9.89 2  265A 7.46 4 
053A 6.83 4  270A 24.67 22 
058A 11.06 2  285D 73.75 42 
070A 157.47 146  287C 84.93 16 
072A 42.28 4  391A 37.47 12 
075A 16.19 6  470A 130.22 63 

 
 
Section 8 Mile Markers 

• 1,658 mile markers were mapped by CDOT employees in Maintenance Section 8. 
• CNHP staff helped to coordinate with CDOT employees to map all pertinent mile markers in 

Maintenance Section 8, and edited/compiled all 1658 mile marker positions from Maintenance Section 8 
into the statewide mile marker GIS map file (Table S8-2). 

 
Table S8-2: Number of GPS mapped mile markers by Route for Maintenance Section 8.  

Route 

Number of 
Mile-

Markers  Route 

Number of 
Mile-

Markers 

 

Route 

Number of 
Mile-

Markers 
002A 40  053A 2  121A 106 



Maintenance Section 8 Results 

Route 

Number of 
Mile-

Markers  Route 

Number of 
Mile-

Markers 

 

Route 

Number of 
Mile-

Markers 
002B 6  058A 22  121B 24 
002C 16  070A 118  128A 34 
006G 62  072A 40  128B 8 
006H 20  075A 14  177A 24 
007D 46  076A 104  224A 10 
008A 40  083A 24  225A 52 
022A 4  085B 48  265A 8 
025A 112  085C 36  270A 22 
026A 12  088A 36  285D 62 
030A 42  088B 16  287C 80 
036B 30  093A 44  391A 38 
040C 76  095A 42  470A 126 
044A 12       

 
  
Section 8 Maintenance Yards  

• 17 maintenance yards were mapped by CDOT employees for a total of 48.08 acres in Maintenance 
Section 8. 

• CNHP staff helped to coordinate with CDOT employees to map Maintenance Section 8 maintenance 
yards, and edited/compiled all 17 maintenance yards from Maintenance Section 8 into the statewide 
maintenance yard GIS map file (Table S8-3). 

 
Table S8-3: Name and acreage for each GPS mapped maintenance yard in Maintenance Section 8. 
Maintenance Yard Name Acres  Maintenance Yard Name Acres 
Arvada 1.22  Pt.1 1.66 
Arvada 1.27  Pt.11 1.33 
Brighton 3.71  Pt.17 1.82 
Broomfield 3.41  Pt.18 2.90 
Havana 6.67  Pt.30 1.50 
Knox Court 1.27  Pt.9 1.35 
P.T.07 3.14  Super Shed 6.88 
P.T.16 2.46  Youngfield 4.20 
Penn. 3.29    

 
 
 Section 8 First Pass Weeds 

• 474 separate weed infested areas totaling 135.79 acres were mapped by CDOT employees in Maintenance 
Section 8. 

• CNHP staff helped to coordinate with CDOT employees to map all weed infestations on lands 
maintained/controlled by Maintenance Section 8, and edited/compiled all 474 separate weed infested area 
segments from Maintenance Section 8 into the statewide first pass weed GIS map files (Figure S8-1, 
Tables S8-4 and S8-5). 



Maintenance Section 8 Results 

Figure S8-1: First Pass Weed Acres
(Primary Weed Species)
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Table S8-4: Number of first pass mapped weed infestations and acres by primary weed species for Maintenance 
Section 8. 

First Pass 
Primary Weed Species 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 277 51.88 
Dalmatian Toadflax 2 0.16 
Diffuse Knapweed 78 62.32 
Field Bindweed 19 4.03 
Hoary Cress 61 10.48 
Leafy Spurge 23 2.74 
Musk Thistle 11 2.58 
Russian Knapweed 3 1.60 
Total 474 135.79 

 
Table S8-5: Number of first pass mapped infestations and acres by minor weed species, when more than one 
weed species was found, for Maintenance Section 8. 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Canada Thistle 1 1.35 
Diffuse Knapweed 3 0.60 
Field Bindweed 1 1.18 
Hoary Cress 2 0.26 



Maintenance Section 8 Results 

First Pass 
Minor Weed Species                   

(when more than one species 
found) 

Number 
Separate GPS 

Mapped 
Infestations 

Total 
Acres 

Leafy Spurge 1 0.06 
Total 8 3.45 

 
 
Section 8 Second Pass Weeds 

• None mapped to date. 
Note: For Second Pass weed mapping, a minimum of 25% of each section is mapped seasonally by CDOT.   
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Setting Up the GeoExplorer 3 for Data Collection 
 

Note:  The steps in this section should only have to be completed once prior to data collection on any 
given project.  Keep this information for reference in case it is needed to restore the GeoExplorer 3. 
 

Uploading the Custom Configurations to the GeoExplorer 3 
 

Make sure the GeoExplorer 3 is in the Support Module.  (It does not matter if the GeoExplorer 3 is on or 
off). 

Open Pathfinder Office 2.51. 
Close the Select Project window. 
Select Utilities->Data Transfer.  The Data Transfer window will open. 
Click the Down Arrow next to Data Type, and select Configuration File. 
Click on Source Directory.  The Source Directory window will open. 
Find the directory (folder) where the configuration file is stored on the computer.  The configuration file 

for this project is named config.ccf. 
 
The Data Transfer window should now look like this (except the Source Directory may be different): 
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Click on config.ccf in the upper box to highlight it. 
Click Add.  The config.ccf file will now also appear in the lower box.  This indicates that 

it is the file to be transferred. 
Click Transfer.  The Associated Files window will open. 
In the Associated Files window, click OK. 
Look at the GeoExplorer 3 to check for an error message.  If no error message is 

displayed on the GeoExplorer 3 and no error message is displayed in Pathfinder 
Office, it can be assumed that the data transfer was successful. 

Close the Data Transfer window by clicking Close. 
 
The GeoExplorer 3 has now been successfully configured for this project.  The configurations will 
prevent the GeoExplorer 3 from collecting data if the spatial accuracy of the data falls below five 
meters. 
 

Editing the Data Dictionary to be Section Specific 
 
Note:  The current data dictionary for this project is WeedsV11 (V11 meaning version 11), and 
therefore, the following directions will refer to the data dictionary as WeedsV11.  Substitute the name of 
a more current data dictionary if necessary. 
 
Go to the directory (folder) on the computer where the data dictionary, WeedsV11, is stored. 
Double click on the WeedsV11 file to open it.  The Data Dictionary Editor window will open with the 

contents of the WeedsV11 file in the view. 
Go to File->Save As and save the file as WeedsV11S#, substituting the # symbol for the specific section 

number where data collection will occur using the data dictionary. 
In the Data Dictionary Editor window, change the name of the data dictionary to WeedsV11S#. 
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Click on Existing_Noxious_Wd to select it.  Selection is signified by a blue box or a blue highlight. 
Click New Attribute.  A New Attribute Type  window will open. 
In the New Attribute Type window, make sure that Menu is selected and click OK.  A New 

Menu Attribute window will open. 
Type “Collector” as the Attribute Name (capital “C” and lower case “ollector”). 
Click New.  A New Attribute Value – Menu Item window will open. 
In the Attribute Value: box, type the name of one of the collectors for the project; last 

name first, first name last, separated by a comma and a space  (e.g. Doe, John).  
After typing each name, click Add. 

Repeat step X until all of the collector’s names for the section data will be collected in 
have been added, then click Close in the New Attribute Value – Menu Item 
window. 

To set a default for this Attribute, double-click the name of the person to be the default 
in the New Menu Attribute window.  The New Attribute Value – Menu Item window 
will reopen.   

Check the default box, and then click OK.   
In the New Menu Attribute window, look over all of the information.  If it looks correct, 

click OK.   
The New Attribute Type window reopens.  Click Close in this window. 
In the Attributes: box of the Data Dictionary Editor window, scroll down to the bottom of 

the list and highlight (single, left click) “Collector” with the (menu symbol) 
next to it. 
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Click the  (up arrow) at the top of the screen to move the new menu-type “Collector” 

attribute to the top of the list. 
Notice that there are two attributes named “Collector” now.  The “Collector” attribute 

with the green “Abc” next to it is a text-type attribute.  The text-type “Collector” 
needs to be deleted.  Highlight the “Collector” attribute with the green “Abc” 
next to it by clicking on it, and then click Delete Attribute.  Confirm deletion. 

The menu-type “Collector” attribute must be added to each of the features, and the text-
type “Collector” attribute must be deleted from each of the features.  Right-click 
on the menu-type “Collector” attribute and select Copy from the list. 

Highlight New_Noxious_Weed by left-clicking it once. 
Right-click in the Attributes section of the window and select Paste.  The Menu-type 

attribute will be added to the list of attributes for New_Noxious_Weed. 
 

XVI 

XVII 
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Use the  (up and down arrows) to move the menu-type “Collector” attribute to the 
top of the list.   

Highlight the “Collector” attribute with the green “Abc” next to it and click Delete 
Attribute.  Confirm deletion. 

Repeat steps XX to XXIII for each of the remaining features (Roads, Mile_Marker, and 
Maintenance_Yard) before continuing on to XXV. 

Highlight Existing_Noxious_Wd in the Features list. 
Double-click on “Section” in the Attributes list to open it. 
Double-click on the section number in the list where data will be collected. 
Click the Default box and then click OK. 
Click OK again to return to the main Data Dictionary Editor window. 
Repeat steps XXV to XXIX for the remaining features (New_Noxious_Weeds, Roads, 

Mile_Marker, and Maintenance_Yard) before continuing on to XXXI. 
Click File->Save to save the changes to the data dictionary.  If a window opens stating 

that the data dictionary is a “Read-Only” file, and asks, “Overwrite the file?” 
click Yes.  Close the Data Dictionary Editor window. 

 
Transferring the Data Dictionary to the GeoExplorer 3 
 
I. Make sure the GeoExplorer 3 is in the Support Module.  (It does not matter if the GeoExplorer 

3 is on or off). 
II. Open Pathfinder Office 2.51. 
III. Close the Select Project window. 
IV.  Select Utilities->Data Transfer.  The Data Transfer window will open. 

Right-click 
anywhere in this 
area and select 
Paste 
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V. Click the Down Arrow next to Data Type, and select Data Dictionary. 
VI. Click Source Directory.  The Source Directory window will open. 
VII. Find the directory (folder) where the data dictionary file is stored on the computer. 
VIII. A list of the available data dictionaries in the selected Source Directory will 

appear in the upper box.  Click on the WeedsV11S#.ddf.  (The full name of the 
data dictionary will probably not display.  The easiest way to make sure that the 
correct data dictionary is selected is to select the data dictionary with the most 
recent date and time.  The date and time listed describes the last time the data 
dictionary was saved.  Since modifications were just made to the data dictionary 
and since these changes were saved, the most recent date and time will be the 
data dictionary to choose.  This may not always be the case; caution is 
advised.) 

IX. Click Add.  The WeedsV11.ddf file will now appear in the lower box signifying 
that it is the file to be transferred to the GeoExplorer 3. 

X. Click Transfer.  (A new window will open showing the transfer progress.) 
XI. Close the Data Transfer window and exit from Pathfinder Office. 
 
The GeoExplorer 3 should now be updated and ready for use. 
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Data Collection Procedures 
 

Using Quick Plan to Plan Data Collection Times 
 
The Quick Plan portion of the Pathfinder Office software is used to determine times when data can and 
cannot be collected according to the configurations of the GeoExplorer 3.  It is particularly useful when 
canyons, valleys, or tree- lined roads will be mapped because Quick Plan can simulate the worst-case 
satellite view by time. 
 

Updating the Almanac in Pathfinder Office 
 
I. Make sure the GeoExplorer 3 is in the Support Module.  (It does not matter if the GeoExplorer 

3 is on or off). 
II. Open Pathfinder Office 2.51. 
III. Close the Select Project window. 
IV.  Select Utilities->Data Transfer.  The Data Transfer window will open. 
V. Click the Down Arrow next to Data Type, and select Almanac. 
VI. Click on almanac.ssf in the upper box to highlight it. 
VII. Click Add.  The almanac.ssf file will now also appear in the lower box specifying 

that it is the file to be transferred. 
VIII. Click Transfer.  A window will open prompting whether to overwrite the old almanac or not.  

Click Yes or OK. 
IX.  Close the Data Transfer window. 
 

Determining Data Collection Times 
 

I. Go to Utilities->Quick Plan. The Plan: session-Untitled window will open with the Select 
Date: GPS week #### window open within it. 

II. Select the date that data will be collected and click OK.  The Edit Point - <City Name> 
window will open.   

III. Click on Cities in the Edit Point - <City Name> window.  The Select City window will open. 
IV.  Scroll through the list of cities and select the city closest to where data will be collected 

(keeping in mind that cities outside of Colorado may be closer than cities within Colorado). 
V. Click OK in the Select City window, and then click OK in the Edit Point - <City Name> 

window. 
VI. Go to Graphs->Number of SVs and PDOP.  The Number of SVs and PDOP window will 

open. 
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How to read the Number of SVs and PDOP Graph: 
 
The top half of the graph, Nsats, represents the number of satellites that can be seen from the selected 
city at the time listed across the bottom of the graph.  The time is local time for the selected city.  At 
least 4 satellites must be in view for data to be collected, and the more satellites in view the better.  
Therefore, if the Nsats graph shows less than four satellites in view, data cannot be collected at the 
corresponding time. 
 
The bottom half of the graph represents PDOP - Positional Dilution of Precision.  PDOP must be 
BELOW 8 for data to be collected.  The lower the PDOP, the better.  PDOP is usually inversely 
proportional to the number of satellites - the more satellites in view, the lower the PDOP. 
 
The GeoExplorer 3 is currently configured only to collect data from satellites that are 15 degrees or 
higher in the sky above the horizon.  The graph should be initially based on this 15 degree “elevation 
mask”.  To simulate a narrower view, such as on a canyon road, tree- lined road, mountainous road, etc., 
the elevation mask can be increased.   

 
Go to Options->Elevation Mask.  The Edit Elevation Mask window will open. 
Change the elevation mask to 30 degrees and click OK.  The graph is automatically updated to show the 
number of satellites that would be in view if a wall at a 30-degree angle extended all the way around the 
view location.  30 degrees usually works well for planning canyon mapping, even though the walls of 
the canyon may be much steeper.  Notice in the PDOP graph that there are now gaps where no 
information (no color) is displayed.  The blank areas represent times when too few satellites (less than 4) 
will be in the view, and therefore, PDOP cannot even be calculated. 
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Using the GeoExplorer 3 with the WeedsV11 Data Dictionary 

 
The GeoExplorer 3’s operating software is divided into three different sections – SYS (abbreviation for 
system), DATA, and NAV (abbreviation for navigation).  Each of these sections has a corresponding 
key on the GeoExplorer 3 keypad.  Further, each section contains several subsections.   
 

THE SYS SECTION 
 

The SYS GPS Subsection 
 

Press the black power button in the lower right corner of the keypad.  The start-up screen (a spinning 
Trimble icon) appears when the GeoExplorer 3 is turned on.  After start-up is completed, the SYS-GPS 
screen appears. 
 

 
 

 
 
This subsection can let the user know why data cannot be collected at certain times.  As seen in the 
above illustration, this window shows what satellites are currently in the GeoExplorer 3’s view, which 
satellites are being used, and the overall health of the signal being received.   
 
Notes on this screen and data collection in general:  Although reception from only four is required to 
collect data, it is entirely possible, and probable, that four or five satellites will be in use, but data 
collection will not be possible.  This can result from poor satellite geometry, poor satellite health, or 
various other satellite signal reception complications.  When the satellite symbol is flashing, the 
GeoExplorer 3 is indicating graphically that data cannot be collected for one or more reasons.  Usually, 
a short wait will alleviate these problems by allowing the satellites to move to better positions or by 
allowing new satellites to move into view.   
 

Raised Tab Indicates 
Current Section and 
Subsection (SYS-GPS) 

Satellites in Use are 
Shaded Black 

Number of Satellites 
Being Used – Must Be At 
Least 4 to Collect Data 

Overall Satellite Health – 
If Flashing, Cannot 
Collect Data 

Signal- to-Noise Ratio 
Meter – Must Be Above 
Mark and Shaded Black to 
Collect Data 

Battery Life Indicator 

Satellites in View, but 
Not in Use, are Outlined 
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Press the SYS button on the keypad to move to the next subsection in the SYS Section.  (Notice the 
raised tab at the top of the screen changes to SYS STATUS). 
 

The SYS STATUS Subsection 
 

The SYS STATUS subsection is self-explanatory.  It shows: 
 

• Memory Status 
• Antenna Status 
• Transfer Status 
• Battery Status 

 
Press the SYS button on the keypad to move to the next subsection in the SYS Section.  (Notice the 
raised tab at the top of the screen changes to SYS SETUP). 
 

The SYS SETUP Subsection 
 

The SYS SETUP subsection is where all of the GeoExplorer 3 configurations are stored – THIS 
SUBSECTION SHOULD NOT BE ALTERED.  Data that is collected with altered settings could be 
rendered useless. 
 
If the SYS button on the keypad is pressed again, the GeoExplorer 3 will return to the SYS GPS Section. 

 
THE DATA SECTION 

 
The DATA section is used to record and store all GPS data.  It will be the most used section for this 
project.  It is important for the user to understand the difference between files, features, and attributes. 
 
A file is where all of the feature data is recorded and stored in the GeoExplorer 3.  Files are what will 
later be transferred to a computer for further use.   
 
A feature  is a physical object on the ground.  For example, a road would be considered a feature.  
Features are the data that will appear on a map.  All of these features are stored in a file.  There are three 
different types of features: point features, line features, and area features.  A point feature will appear as 
a point on the map, a line feature will appear as a line on the map, and an area feature will appear as an 
area (or a solid object) on the map. 
 
Attributes are data that describe a feature.  For example, an attribute of a road would be “road surface 
type”.  That is, whether a road (feature) is dirt, gravel, or paved describes that road, and therefore, the 
road surface is an attribute of the road feature.  Each feature may have several attributes to describe it. 
 
The following illustrates how files, features, and attributes interrelate: 
 

File 
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Feature  Feature  Feature 
 
 

Attribute  Attribute  Attribute    Attribute 
 Attribute  Attribute   Attribute  Attribute 

 Attribute 
 

 
The DATA FILE Subsection 

 
Press the DATA button on the keypad to move to the DATA-FILE Subsection.  (Notice the raised 
tab at the top of the screen is now DATA-FILE). 
 
 

   
 

Since thousands of files will be created over the course of this project, a meaningful name needs to be 
given to each file to help facilitate organization.  A file naming convention has been devised for this 
project.  It works as follows: 

 

Raised Tab Indicates 
Current Window – 
DATA-FILE 

Name of File to be 
Created 

Number of Satellites 
Being Used – Must Be At 
Least 4 to Collect Data 

Overall Satellite Health – 
If Flashing, Cannot 
Collect Data 

Name of Data 
Dictionary that will be 
used to Collect Data in 
the File 

GPS Data Configuration 
that will be used in the 
File (Should be 
CDOTconfig for this 
project) 
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Section Number-Patrol Number-Date 
 
For Example: S3P2201-08-22                           Another Example:  S6P1601-08-23 
 
Section #     Patrol #     Year     Month     Day 
 
Notes on the File Naming Convention: 
 

• It is crucial that this file naming convention is followed to prevent problems finding and 
archiving data in the future. 

• If either the day or the month is a single digit, use a zero prefix (i.e. 00-09-06 for September 6, 
2000). 

• A new file should be created whenever the patrol that is being mapped changes, or when the date 
that the mapping is being done changes. 

• It is okay if the data from one patrol spans multiple files due to mapping the patrol on different 
dates. 

• When zeros are being used, it is crucial that the number 0 (zero) is used and not the letter “O”. 
• If for one reason or another it is desirable to create multiple files with the same name (same day 

and patrol), it is okay to use a letter at the end of the file name to differentiate the files.  (e.g.  
S5P3401-03-19A) 

 
Naming and Creating a New File 

 
I. Press the Down Arrow on the keypad of the GeoExplorer 3 to highlight “File: R0#####A”. 
II. Press the ENTER key on the keypad.  A text screen will open. 
III. Press the Down Arrow on the keypad to select BKSP (short for “backspace”). 
IV.  Press the ENTER key on the keypad to backspace and delete the default name (R0#####A) 

until the top line is blank. 
V. Use the Arrow Keys on the keypad to highlight “S” and press ENTER on the keypad to add it to 

the name.   
VI. Now, highlight the appropriate section number where data will be collected and press the 

ENTER key on the keypad to add this character to the file name. 
VII. Repeat step VI until the full name has been entered on the top line, making sure the name 

specifically follows the previously described naming convention. 
VIII. When the name is completely typed on the top line, either highlight CLOSE in the window and 

press ENTER on the keypad, or press CLOSE on the keypad.  The name entered will now 
appear next to File: 

IX.  Make sure WeedsV11S# is listed next to Dictionary.  If it is not, use the Arrow Keys on the 
keypad to highlight Dictionary and press ENTER on the keypad.  Select the WeedsV11S# data 
dictionary from the list and press ENTER on the keypad. 

X. Also make sure that CDOTconfig is listed next to Configuration:.  If it is not, the custom 
configurations will have to be uploaded again. 

XI. Once the file name, dictionary, and configuration are correct, use the Arrow Keys on the 
keypad to highlight Create new file and press the ENTER key.  The DATA FILE window now 
becomes the DATA NEW window.   
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The DATA NEW Subsection 
 

The window displays New feature with a list of features below it.  This is the data dictionary.  The data 
dictionary contains a list of all of the features that need to be collected for this project.  The view will be 
similar to the one seen below, but the list will show: 
 

• Existing_Noxious_Wd 
• New_Noxious_Weeds 
• Roads 
• Mile_Marker 
• Maintenance_Yard 

 

 
 
 
 
 
 
 

General Notes on Data Collection with the GeoExplorer 3 
 

The GeoExplorer 3 offers two options when collecting features, Now and Later.  If Now is selected 
when creating a new feature, the GeoExplorer 3 will begin logging positions immediately.  That is, the 
GeoExplorer 3 will begin mapping its location immediately.  Attribute information can be entered about 
a feature while the GeoExplorer 3 is logging positions. 

If Later is selected when a feature is created, the GeoExplorer 3 will be paused allowing the user to 
move the unit to a different location before it begins logging positions.  This is advantageous because 
the user can enter all of the attribute information about the feature before logging any positions.  The 
GeoExplorer 3 will begin logging positions when the Pause (Log) button is pressed.  Using Later is 
recommended until the user is very comfortable with the GeoExplorer 3. 

Number of Satellites 
Being Used – Must Be At 
Least 4 to Collect Data 

Overall Signal Health – If 
Flashing, Cannot Collect 
Data 

Data Dictionary – 
WeedsV11S# Data 
Dictionary will have 
Different Features 
 

Raised Tab Indicates 
Current Section and 
Subsection – DATA 
NEW 

With Now and a New 
feature highlighted, 
positions for that feature 
will be logged 
immediately. 

With Later and a New 
Feature highlighted, the 
feature will open to 
enter attributes, but 
position logging will be 
paused. 
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If a feature is accidentally created or if positions are accidentally logged, the feature can be cancelled 
without being stored.  By pressing Fn (function) and then CLOSE on the keypad (which performs the 
Cancel command if pressed following Fn), the GeoExplorer 3 will ask the user if they wish to “Cancel 
the Feature”.  If “Yes” is selected, the feature will not be stored. 
 
A feature cannot be stored without entering data into all of the required attributes.  The GeoExplorer 3 
will beep and bring up an Error! window letting the user know that information needs to be entered into 
a specified field before the feature can be stored. 
 
It is often easy to collect faulty data or overwrite existing data when the data collector is in the wrong 
subsection.  For example, if the GeoExplorer 3 is in the DATA UPDATE subsection and not the DATA 
NEW subsection, any positions collected will overwrite the positions that were collected earlier. 
 
The different sections of the GeoExplorer 3 can be accessed in conjunction with one another.  For 
example, if data is being collected and satellite reception becomes poor, SYS can be pressed on the 
keypad to temporarily leave the DATA section and look at the SYS STATUS screen.  After viewing the 
locations of the satellites, DATA should be pressed again to return to the DATA NEW screen to 
continue data collection. 
 
Important Things to Keep in Mind When Collecting Line Features (Existing_Noxious_Wd and Roads). 
 

• When collecting Existing_Noxious_Wd data, make sure to set the offset prior to collecting any 
data. 

• If satellite reception is lost, press LOG (pause) and wait until satellite reception improves.  (The 
GeoExplorer 3 will stop beeping and the satellite icon or number on the satellite will begin 
flashing if satellite reception becomes poor.  When the satellite icon and the number over it stops 
flashing, it is safe continue logging positions.) 

• Make every effort to continue moving while collecting line features. 
• FEATURES MUST BE CLOSED WHEN COMPLETED, NOT JUST PAUSED!!!  If the 

GeoExplorer 3 is paused while a feature is open, then moved to another location, then taken off 
of pause, the GeoExplorer 3 will connect the area between where the GeoExplorer 3 was 
originally paused and then resumed with a straight line.  The feature must be closed, NOT the 
file. 
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Collecting Existing_Noxious_Wd Features 
 

Existing_Noxious_Wd is a line feature.  In other words, a line on a map will represent this feature.  The 
line will later be converted to an area feature at a different stage in the process, but for efficiency 
purposes, it will originally be collected as a line feature.  For a list of weeds that will be mapped as 
existing noxious weeds, please see Appendix A at the end of this manual. 
 
Make sure that Existing_Noxious_Wd is highlighted.  Press the Right Arrow key on the keypad to select 
Later.  Press ENTER on the keypad when both Existing_Noxious_Wd and Later are highlighted.   
 
The attributes to be entered for an Existing_Noxious_Wd feature will appear in the window.  Notice the 
flashing symbols in the lower right corner of the screen.  The two flashing bars illustrate that the 
GeoExplorer 3 is not collecting positions because the unit is paused. 
 
 

 
 
 
 
The highlighted area should be Collector.  Press ENTER on the keypad.  Use the Arrow Keys on the 
keypad to select the name of the individual collecting the data.  When the correct name is highlighted, 
press ENTER on the keypad to store that name. 
 
Press the Down Arrow on the keypad to move down to the Date, the next attribute in the list.  The Date 
attribute is automatically generated and, therefore, will never need to be modified. 
 
Press the Down Arrow key again to move to Section.  This should have defaulted to the correct section 
number.  If the default is not properly set, double check the modifications made to the data dictionary in 
Pathfinder Office, make corrections if necessary, and upload the data dictionary again with the correct 
section number defaulted.  Having the proper section number defaulted will save a lot of time and 
reduce the risk of errors. 
 

Name of Feature that 
will be Logged – 
Currently should be 
Exising_Noxious_Wd 

Attributes List – 
Existing_Noxious_Wd 
attribute list will be 
much longer 

Two Vertical Flashing 
Bars indicate that no 
positions are being logged 
– The GeoExplorer 3 is 
Paused 

Number of Satellites 
Being Used – Must Be At 
Least 4 to Collect Data 

Overall Satellite Health – 
If Flashing, Cannot 
Collect Data 

A 0 (zero) will appear 
on the screen showing 
that no positions have 
been collected. 
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Press the Down Arrow on the keypad to move down to Patrol, the next attribute in the list.  Press the 
ENTER key on the keypad to open the Patrol attribute.  Use the Arrow Keys on the keypad to change the 
number 0 (zero) to the patrol number that is being mapped.  Press ENTER to store this information. 
 
Press the Down Arrow on the keypad to select Route and press ENTER.  Enter the number and letter of 
the route being mapped.  This field is limited to four characters.  Only type in the number and letter of 
the route being mapped.  It is not necessary or desired for “hwy,” “interstate,” etc. to be entered.  Also, if 
a route is being mapped that is only a single or double-digit number, enter a “0” (zero) before the rest of 
the information.  It is crucial that the number “0” (zero) is used and not the letter “O”.  For example, if 
State Highway 83 area “F” is being mapped, “083F” should be entered into the Route field.  Press 
CLOSE or ENTER to store the data. 
 
Note:  For the rest of this section, only descriptions of what is desired in each field will be given. 
 
ROW_Width_in_Feet :  The information to be entered in this attribute is the width of the right-of-way on 
the side of the road where the weeds are being mapped.  The distance between the outer edge of the road 
surface and the edge of the right-of-way should be estimated as accurately as possible. 
 
Primary_Wd:  Scroll through the list in this attribute and select the weed that is dominant in the area 
being mapped. 

 
Note:  If one type of weed is being mapped as the primary weed, and another weed becomes the 
dominant weed, close the line feature being mapped.  In a new Existing_Noxious_Wd feature, 
change the primary weed to whatever has become the dominant weed. 

 
PW_Cover:  Enter what percentage of the ground the primary weed covers. 
 
PW_Contain:  Are the primary weeds contained on the right-of-way?  If the primary weeds being 
mapped are also growing outside of the right-of-way, enter “No” in this attribute.  If the primary weeds 
are growing only within the right-of-way, enter “Yes” in this attribute. 
 
Second_Wd:  If another weed is also present in the same area being mapped, but is not as prevalent as 
the primary weed, list it in the Second_Wd attriubte. 
 

Note:  Second_Wd, SW_Cover, and SW_Contain are not required fields because there may not 
always be a secondary weed. 

SW_Cover:  Enter what percentage of the ground the secondary weed covers. 
 
SW_Contain:  Are the secondary weeds growing only on the right-of-way? 
If the secondary weeds being mapping are also growing outside of the right-of-way, enter “No” in this 
attribute.  If the secondary weeds are growing only within the right-of-way, enter “Yes” in this attribute. 
 
Comments:  The “Comments” attribute is in all of the features.  Use it to describe anything that may be 
important that is not covered by the data dictionary.  Hopefully, the data dictionary has been constructed 
well enough that this attribute will not be needed very often.  The Comments attribute can also be used 
for personal notes and reminders. 
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One more step must be performed before positions can be logged when using the Existing_Noxious_Wd 
feature.  An offset equal to half of the width of the right-of-way on the side of the road being mapped 
must be established.  THIS STEP IS VERY IMPORTANT!!!  If it is not done, all weeds will look like 
they are growing on the road!!! 
 

Setting an Offset 
 

Before logging positions (i.e. taking the GeoExplorer 3 out of pause mode), an offset must be 
established when mapping Existing_Noxious_Wd’s.  The GeoExplorer 3 will not map a feature where 
the antenna is located when an offset is specified; instead it will map a feature where the offset specifies.   
 
An offset for a line feature (e.g. Existing_Noxious_Wd) offers 3 options: Direction, Horizontal 
Distance, and Vertical Distance.  For this project, only Direction and Horizontal Distance will be used.  
Direction is used to specify which way from the true antenna location the line feature is to be created, 
taking into account the direction of travel of the antenna.  Horizontal Distance is used to specify how far 
from the true antenna location the line feature is to be created.   
 
For example, if the antenna is placed on a vehicle that will be moving forward, the offset should be set 
with a Direction of RIGHT to map weeds on the right side of the road.  The Horizontal Distance should 
equal half of the right-of-way width on the right side of the road (which should be equal to half of the 
ROW_Width_in_Feet attribute).  For the sake of the example, imagine the right-of-way on the right side 
of the road is 50 feet wide and the weeds to be mapped are on the right side of the road.  The offset 
Direction should be set to Right and the Horizontal Distance should be set to 25 feet (50/2 = 25).  If the 
offset has this setup, the line feature on a map will show the line 25 feet to the right of the true antenna 
location when the feature was created. 
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To set an offset: 

 
 

To set the offset: 
 
I. Note the distance entered in the ROW_Width_in_Feet attribute, and then press the OPTION key 

on the keypad.   
II. A new window will open with Offset highlighted.  Press ENTER on the keypad. 
III. Make sure the direction is correct.  If weeds being mapped are on the right side of the road, the 

direction should be right.  If the weeds being mapped are on the left side of the road (medians), 
the direction should be left. 

IV.  Use the Down Arrow on the keypad to highlight Horz. Distance and press ENTER.  Set this 
distance to half of the ROW_Width_in_Feet and press ENTER or CLOSE.  The Vertical 
Distance field will not be used for this project, and therefore, should be left at 0 feet. 

V.  Press CLOSE to store the offset. 
 

Logging Positions 
 

The GeoExplorer 3 is now ready to begin collecting positions.  Line the antenna up as close as possible 
to the edge of the road.  The antenna should be placed on the hood of the vehicle above the front right 
tire or over the passengers seat on the roof of the vehicle.  Press the LOG key to begin collecting 
positions.  Begin moving immediately.  If it is necessary to stop, press the LOG key again to pause the 
unit. 
 

25 Feet 

Path and direction the 
GeoExplorer 3’s antenna 
actually followed. 
 

Location of line on map with 
Offset Direction – Right; Horz. 
Distance – 25 feet 
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The GeoExplorer 3 makes it apparent that positions are being logged in three ways: 
 

• An audible beep; 
• The moving pen symbol in the lower right corner of the window; 
• The counter showing the number of positions that have been logged. 

 
When the end of the feature has been reached (either at the end of the section of weeds or at a change in 
the species of primary weed) press CLOSE (or press LOG and then CLOSE).  The feature will be stored. 
 
The GeoExplorer 3 should now be back at the New Feature  window. 
 

Collecting New_Noxious_Weeds Features 
 

To see a printed list of what should be mapped as a New_Noxious_Weeds feature for this project, see 
Appendix A.  (All of the new weed’s scientific names are preceded by an *.)  These are relatively new 
species of noxious weeds to the state of Colorado. 
 
A New_Noxious_Weeds feature will be taken as a point feature.  It is extremely important that new 
noxious weeds are mapped accurately so that control measures can be taken promptly.   
 
To map using the New_Noxious_Weeds feature: 
 
I. Stand over the location of the plant (or in the middle of the plants if there are several of them).   
II. Make sure that New_Noxious_Weeds and Later are highlighted and press ENTER on the 

keypad. 
III. Complete all attribute information for the weeds being mapped.  The attributes for the 

New_Noxious_Weeds feature should be completed in the same manner as the attributes in the 
Existing_Noxious_Weeds feature. 

The Two-Vertical Bars 
indicating Pause Mode 
disappear and the “writing 
pen” icon begins to move 
to indicate that positions 
are being collected. 

This number represents 
the number of positions 
that have been logged for 
the feature. 
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IV.  Resume the GeoExplorer 3. At least ten positions must be collected for point features or the 
GeoExplorer 3 will not allow the feature to be stored.  It is okay if more than ten positions are 
collected.  The GeoExplorer 3 will average the positions logged for a point feature so that only 
one position is represented on a map. 

V. Press the CLOSE button on the keypad to store the feature. 
 
If possible, destroy any new noxious weed species before returning to your vehicle. 
 

Collecting Roads Features 
 

The main purpose for collecting the Roads feature is for locational reference purposes.  Collecting this 
feature will help to differentiate the weed data collected on each side of the road, in the medians, etc.  It 
has been requested by the CDOT Weed Coordinator that the road segments be mapped based on each 
Section’s Log of Patrols so the data may be used for other projects in the future, and so the road data can 
be queried by patrol for future analysis.  The Roads feature is a line feature.   
 
To collect a Roads feature: 
 
I. Highlight Roads and Later in the New feature list and press the ENTER key on the keypad.   
II. Enter all of the attribute data for the road to be mapped.   
III. With the antenna mounted on the vehicle, position the antenna over the middle of the 

pavement, press the LOG key, and begin driving.  Always attempt to keep the antenna over the 
middle of the pavement.  If the road changes from two lanes to three lanes, if an acceleration 
lane becomes available, etc., still attempt to keep the antenna over the middle of the pavement.   

IV.  When you have finished logging positions for the road, press CLOSE on the keypad (or LOG 
and then CLOSE on the keypad) and the feature will be stored.   

 
 
Three attributes are required for Roads features that are not required for Existing_Noxious_Wd or 
New_Noxious_Weeds.  The Road_Type attribute offers three choices:  Main_Hwy, Frontage_Road, or 
Ramp.  The type of road being mapped should be specified in this field.  If the type of road being 
mapped is not accommodated by one of these three choices, use the type that closest describes the road 
type and manually enter the real road type in the Comments attribute.  Roads going to or through a rest 
area (or other such facility) should have a Road_Type of Ramp and a comment should be entered in the 
Comments attribute stating that the road is a “Rest Area Road”.  
 
The Ref_Pt will be the beginning of the road according to the Log of Patrols.  When mapping ramps, an 
estimate should be included for the Ref_Pt attribute.  For example, if the ramp begins 0.70 miles after 
mile marker 22 on a given highway, 22.70 should be entered into the Ref_Pt field.  When mapping 
ramps, this information does not have to be entered while collecting data.  It can be entered in the office 
using the measuring tool in Pathfinder Office.  
 
The EndRef_Pt should be the end of the road according to the Log of Patrols.  When mapping ramps, it 
is NOT necessary to complete this attribute.  If this attribute is not being used while mapping ramps, it 
must be left at or changed back to zero. 
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Collecting Mile_Marker Features 
 
The Mile_Marker feature is a point feature.  To map a mile marker, position the antenna over, or as 
close as possible, to the mile marker post.  The most efficient method of mapping mile markers is to 
place the antenna on the vehicle in a position that makes it possible to get the antenna close to the mile 
marker post without removing it from the vehicle.  The vehicle can then be pulled over to the side of the 
road to get the antenna as close as possible to the mile marker post.  
 
All of the attributes for the mile markers should be easily understood, as they are the same as those in 
the Roads feature.  Enter the number of the mile marker post in the Ref_Pt attribute.  As with the 
New_Noxious_Wd feature, the Mile_Marker feature is also a point feature and requires that ten positions 
be collected. 
 
All whole numbered roadside mile markers must be mapped.  It is unnecessary to map mile markers that 
are at tenths of a mile or otherwise.  If a mile marker is missing, estimate, as accurately as possible, 
where the mile marker post should be located and map that location as if the mile marker post existed.  
In the Comments for a mile marker post that is missing, enter “MMM”, “MM Missing”, or “Missing” to 
bring attention that a post does not currently exist.  This should help to spare confusion of weed 
locations in the future if a mile marker post is replaced in a different location than mapped. 
 
“Fictitious” mile markers need to be mapped at the beginning and end of each patrol section of a road.  
These should be mapped the way a missing mile marker post is mapped, but no comment is necessary.  
The Ref_Pt attribute should contain the location of the beginning or end of the patrol according to the 
Log of Patrols.  It is NOT necessary to map fictitious mile markers for ramps or frontage roads. 
 

Collecting Maintenance_Yard Features 
 
The Maintenance_Yard feature is an area feature.  Use this feature to map the fence line of maintenance 
yards, rest areas, or any other type of facility.   
 
To map a maintenance yard or other facility: 
 
I. Highlight Maintenance_Yard and Later in the New feature list and press the ENTER key on the 

keypad.  
II. Enter all of the attribute information for this feature.  The Yard_Name attribute should be 

completed with the generic name for the yard (e.g. Aurora Yard). 
III. Walk to a corner of the fence and press LOG on the keypad to resume the GeoExplorer 3 and 

collect positions.   
IV.  Collect about 5 positions and then press LOG on the keypad again to pause the GeoExplorer 3.   
V. Go to the next corner of the fence and press LOG again on the keypad to resume the unit.  

Collect about 5 positions, pause the unit, go to the next corner, and resume it again.  Do this for 
each corner of the fence line.   

VI. Return to the corner of the fence at which positions were originally logged and collect about 5 
more positions.   

VII. Close the feature by pressing the CLOSE button on the keypad.   
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IT IS EXTREMELY IMPORTANT THAT AT LEAST A FEW POSITIONS ARE COLLECTED AT 
EACH CORNER!   
 

Using the Repeat Function 
 

The purpose of the Repeat Function is to repeat all of the attributes that were entered the last time a 
feature was created.  The first time one of the feature types is mapped within a file, all of the attribute 
information will have to be entered.  After this initial use of a particular feature, all of the attribute 
information previously entered for that feature will be repeated if the Repeat Function is enabled.   
 
For example, the first time a mile marker is mapped within a file, all of the attribute information will 
have to be entered (i.e. Collector, Date, Patrol, Route, Ref_Pt, and Comments).  The next time a mile 
marker is mapped, all of this same attribute information that was entered the first time will automatically 
be re-entered for each attribute.  So if the person collecting the data were mapping on the same route and 
patrol, the only attribute that would need to be changed would be Ref_Pt the next time a mile marker is 
mapped. 
 
To turn on the Repeat Function, press the OPTION key on the keypad when the GeoExplorer 3 is in the 
DATA NEW window (in the New Feature/Data Dictionary view).  Two options are presented.  Make 
sure that Repeat is highlighted and press the ENTER key.  A checkmark should appear in the box next to 
Repeat showing that this function has been enabled.  Press the CLOSE button. 
 
Important Things to Remember when Using the Repeat Function: 

 
• OFFSET DATA IS NOT REPEATED!!!  Offset information must be re-entered each time a 

feature is mapped that uses offsets.   
• It is important to verify that all of the repeated information is correct; be sure to overlook all of 

the attribute information every time a new feature is created.  The Repeat Function is either on or 
off; Repeat cannot be turned on for one feature, but not for another.  Repeat cannot selectively be 
set per feature.  If it is on for one feature, it is on for all of the features. 

 
Closing and Saving the File 

 
When data collection is complete for a patrol or for the day, press the CLOSE button on the keypad.  The 
GeoExplorer 3 will prompt, “Close rover file?”  Entering Yes will save and close the file; entering No 
will keep the file open for further data collection. 
 
When the GeoExplorer 3 is shutdown, the unit stores any information that it has collected.  It is 
recommended that a file be closed before the GeoExplorer 3 is shutdown.  Although rare, the software in 
the GeoExplorer 3 has been known to corrupt some data if the files are not closed prior to shutdown. 
 

Opening an Existing File 
 

After a file has been stored on the GeoExplorer 3, the DATA FILE window will offer two options.  One 
option, which was already covered earlier, is Create New File.  Open Selected File is the other option.   
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To open a file that was created earlier on the GeoExplorer 3: 
 
I. Highlight Open Selected File by using the Arrows on the keypad.   
II. While Open Selected File is highlighted, press the Down Arrow to highlight File.   
III. Press the ENTER key on the keypad to bring up a list of the files that can be opened.   
IV.  Highlight the name of the file to open and press ENTER.  The GeoExplorer 3 will return to the 

DATA FILE window.   
V. Use the Up Arrow on the keypad to highlight Open Selected File again and then press the 

ENTER key.  The selected file will open the DATA UPDATE subsection. 
 

The DATA UPDATE Subsection 
 

The DATA UPDATE subsection will display the list of features previously collected in a file that was 
re-opened.  This subsection is also available to view the features that have been collected in a new file.  
The features in the list will appear in the order they were collected.  If attribute information needs to be 
modified for a previously collected feature, these modifications can be made in the DATA UPDATE 
subsection.  Using the Arrows on the keypad, select the feature that needs to have its attributes updated 
and press the ENTER key on the keypad. The attribute information will be listed for that file.  Make the 
necessary modifications, and press CLOSE on the keypad to save the changes.  Use caution when in the 
DATA UPDATE subsection.  It is fairly easy to make undesired changes to attribute data or spatial data 
of a feature.   
 
To collect new features in the file, press the DATA key on the keypad twice (once will open the DATA-
MAP subsection) to enter the DATA NEW subsection.  The DATA NEW subsection, which displays 
the data dictionary, is the same subsection that was used to collect features originally.  The DATA NEW 
subsection can be used exactly as it was when the file was originally created to collect new feature data. 

 
The DATA MAP Subsection 

 
A file must be open for the DATA MAP subsection to be available.  To look at a simple view of the data 
that has been collected within a file, press the DATA key on the keypad until the DATA MAP tab is 
raised at the top of the screen.  An hourglass icon will probably appear while the GeoExplorer 3 
generates a map view.  Eventually, the features that have been collected within the file will be displayed 
in the map view.  To zoom in on a particular feature or area of the map, use the Arrow Keys on the 
keypad.  Once one of the arrow keys have been pressed, crosshairs will appear on the screen.  Use the 
Arrow Keys on the keypad to move the crosshairs to the area of the map to be zoomed in on.  Press the 
OPTION key on the keypad and select Zoom in.  The hourglass will reappear while the new, zoomed in 
view is created.   To zoom back out to the extent of the map view, press the OPTION key on the keypad 
and select Zoom extents. 
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Pathfinder Office Procedures Following Data Collection 
 

Using Pathfinder Office“Projects” 
 

When Pathfinder Office is initially opened, the Select Project window appears.  A “Project” in 
Pathfinder Office is an organizational tool.  Creating a Project creates a new folder (directory) in the 
Pfdata folder on the computer’s hard drive.  When a Project is selected, all data transferred to the 
computer from the GeoExplorer 3 will be stored in this folder.  The Project is only specific to the 
computer that the GPS files are initially being processed on, and therefo re, it has no pertinence to 
anyone that will be viewing the data on a different computer.   
 
Using “Projects” in Pathfinder Office is optional, but many users find it very user- friendly.  Others 
prefer to use the “Default” project for everything and then organize the data in a different manner later. 
 
To use a Project: 
 
I. Open Pathfinder Office.  The Select Project window will automatically open each time 

Pathfinder Office is opened. 
II. In the Select Project window, click New. 
III. In the Project Name field of the Project Folders  window, enter a name for the project to be 

created.  Some different ways to organize the data (and name projects) may include creating a 
new project for each month, day, patrol, or supervisor’s section.   

IV.  Once the desired name is entered in the Project Folders window, click OK, and then click OK 
again.  The name should now appear in the box in the Select Project window.  This process 
just created a new folder named whatever the new project was named in the Pfdata folder 
(typically on C: drive). 

V. Click OK in the Select Project window.  All data transferred to the computer and all base 
station files will now be transferred into this new projects folder until Pathfinder Office is 
closed or until a different project is selected. 

 
To select a different (but already existing) project to store data in, click the down arrow next to Project 
Name in the Select Project window.  A list of the available projects will drop down.  Select the desired 
project and click OK. 
 
To select a different project after Pathfinder Office has previously been opened and a project previously 
selected, go to File->Projects.  The Select Project window will open. 
 

Transferring Data from the GeoExplorer 3 to the Computer 
 
I. Make sure the GeoExplorer 3 is in the Support Module.  (It does not matter if the GeoExplorer 

3 is on or off). 
II. Go to Utilities->Data Transfer.  The Data Transfer window will open.  A list of the files 

collected on the GeoExplorer 3 will be in the upper box. 



Appendix A – GPS Field and Computer Procedures Manual 

 

III. Click on a file in the upper box to select it, and then click Add.  Repeat this process until all of 
the files to be transferred are listed in the lower box. If it is desired to transfer all of the files on 
the GeoExplorer 3 to the computer, click Add All.   

IV.  Click Transfer.  A new window will open showing the files transferring from the GeoExplorer 
3 to the computer. 

V. After the files are finished transferring, click Close to close the Data Transfer window. 
 

Differentially Correcting the Data 
 

After transferring the data from the GeoExplorer 3 to the computer, the data needs to be differentially 
corrected to increase its spatial accuracy.  Differential correction compares the inaccuracies of data 
collected at a known location and makes calculated adjustments to data collected in the field.  This, in 
turn, increases the accuracy of the data collected in the field.   
 
A base station consists of a GPS unit positioned above a surveyed high accuracy point.  The GPS unit 
continually collects positions from the GPS satellites and downloads them to a computer.  Since the 
exact location of the GPS unit is known, the computer can calculate specifically the inaccuracy of the 
satellite readings the GPS unit is receiving at a specific time by comparing those readings to the known 
location.  This information can then be compared to the data collected on the GeoExplorer 3 in the field, 
and this raw data can be corrected to make it more accurate.   
 
For example, if the data that the GPS unit at the base station collected at 12:33 p.m. on January 12, 2000 
was off by 12 feet to the north of the high accuracy point, any data that GeoExplorer 3 was collecting 
out in the field at that time would be off about that same distance and direction.  Of course, due to 
several uncontrollable variables, this method is not completely accurate, but differentially corrected data 
is almost always more accurate than raw data collected with the GeoExplorer 3. 
 
It is necessary to wait until the top of the current hour to perform differential corrections.  The base 
station files used for differential correction are collected for an hour before they are posted to the 
internet for download.  Without all of the necessary base station data, differential corrections cannot be 
performed, so it is important to wait until all of the necessary base station files have been posted to the 
internet and are available for download. 
 
For example, if data collection ended at 3:15 p.m., it would be necessary to wait until after 4:00 p.m. to 
perform differential correction.  More specifically, if data collection ends between 3:00 p.m. and 3:59 
p.m., it will be necessary to wait until 4:00 p.m. to perform differential corrections.  This wait is required 
so that the base station computer has had time to post its data on the internet for downloading.  It is 
recommended that data collection ends five minutes prior to the top of the hour and that a wait of five 
minutes after the top of the hour is exercised to ensure that a difference in the user’s clock and the base 
station’s clock is accommodated.  
 
To perform differential corrections: 
 
I. Make sure the computer is connected to the internet. 
II. Go to Utilities->Differential Correction.  The Differential Correction window will open.  A 

list of the files that were just transferred will be in the upper box.  If no files or the incorrect 
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files are displayed in the upper box, click Browse next to the upper box and find the files that 
need to be corrected. 

III. Click Internet Search.  The Internet Search window will open. 
IV.  Click New.  The New Provider window will open. 
V. Select Copy the most up-to-date list from Trimble’s Internet site, and select from it.  Click OK 

in the New Provider window.  The Select a Provider window opens with a list of base station 
providers.  The closest base station to where the data was collected will be listed first. 

VI. DO NOT USE A “CORS” BASE STATION!  Otherwise, select the provider that is the shortest 
distance from where the data was collected.  The distance is shown next to the name of the base 
station in the Select a Provider window.  Also, do not attempt to use a base station that is over 
300 miles (roughly 480 kilometers) from where the data was collected.  Click on the desired 
provider to select it and click OK.  A Provider Properties window opens.   

VII. Click OK.  The Internet Search window opens.   
VIII. Click OK.  The files should begin to transfer in no more than 30 seconds. 
IX.  When the files have completed transferring, the Confirm Selected Base Files will open 

automatically.  In this window it is very important to make sure the Coverage is 100%.  As 
long as coverage is 100%, click OK and continue onto X.  If coverage is not 100% or if the files 
did not transfer, click Cancel, return to Step III and complete all of the steps over again using a 
different provider.   

X. In the Reference Position window click OK.  The Differential Correction window will open.   
XI. Click OK.  Several windows will open displaying the processes of the files being corrected, and 

then the Differential Correction Completed window will open.  IN THE DIFFERENTIAL 
CORRECTION COMPLETED WINDOW, MAKE SURE THAT “100% OF THE 
SELECTED POSITIONS WERE CODE CORRECTED”! 

XII. If this figure is less than 100%, return to Step II and perform the differential corrections over 
again using a different base station.  If the figure is 100%, differential corrections were 
successful.   

 
Regardless of whether 100% of the positions were corrected or not, a new file was created in the 
directory (folder) of the project that you selected when you first opened Pathfinder Office.  This file will 
have the same name as the original file, but it will have a .cor extension (i.e. raw file = S1P2100-09-
08.ssf; corrected file = S1P2100-09-08.cor).  Further, differentially corrected (.cor) files will have a 
“target” icon, whereas raw (.ssf) files will have an “Earth” icon. 
 

Quality Checking Data 
 

It is important to ensure that all of the data collected in the field was collected and attributed correctly.  
Only the individuals collecting the data know what they did (or were attempting to do) in the field, and 
therefore, those individuals need to quality check the data.   
 
A commonly used (and very sensible) acronym related to computer work is GIGO, meaning “Garbage 
in, garbage out”.  In other words, if the data that is being introduced to a dataset is not of the utmost 
quality, any future work done with the dataset will be worthless and potentially damaging to a project 
due to the dataset’s inaccuracies.  The bottom line is that extreme care needs to be taken when quality 
checking the data. 
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Opening a File 
 

I. In the main Pathfinder Office window, go to File->Open.  The Open window opens with the 
option to view the data within a file.  It may be necessary to browse through the Open window 
to find the files on the computer.  The files listed with the “target” icon are the corrected (.cor) 
files.  The files listed with the “Earth” icon are the raw (.ssf) files.  It is the corrected files that 
should be reviewed and modified if necessary.  The raw files should NOT be modified in any 
way. 

 Tip:  To simplify this window so that only the corrected files are displayed, click on the down 
arrow next to file type and select Corrected files. 

II. Select the Corrected file to view in the list by clicking on it once and then click Open.  The 
name of the file that has been opened will appear in the title bar at the top of the screen. 

III. The four small icons to the right of the small printer icon may need to be clicked to display the 
Map window, the Time Line  window, the Feature Properties window, and the Position 
Properties window.  Rearrange the windows so that all of them can be viewed at the same 
time.  Once the windows have been arranged, they will always open in these positions.  See the 
illustration below for a suggestion of how to arrange these windows.   
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When opened, the Map window will display the spatial data from the file.  The Feature Properties 
window will display the attributes for each feature from the file.  The Time Line window will display 
the time at which each feature was collected in the file.  The Position Properties window will display 
each individual position’s properties from within each feature from the file. 
 
Notes:  Multiple files can be opened at once by holding down on the control key (Ctrl) on the computer 
keyboard while clicking on each file, and then by clicking open when all of the files are selected.  When 
more than one file is opened, no modifications can be made to any of the files.  This method strictly 
allows the user to view the data from multiple files at the same time. 

 

Click these Icons to Open the Map, 
Time Line, Feature Properties, and 
Position Properties Windows 
 

Map 
Window 

Feature 
Properties 
Window 

Time Line 
Window 

Position 
Properties 
Window 
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Opening a Background File 
 

The Background Function allows the user to view multiple files in the Map window and still be able to 
edit the contents of one file.  The spatial data from the background files will be seen in the Map 
window, but no attribute data will be accessible on the background files.   

 
I. Go to File->Background.  The Local Background Files window will open. 
II. Click Add to open the Add Background Files window.   
III. Browse in this window to find the file(s) that will be viewed in the Map window as a 

background.  Select one or multiple files (by holding down the control key on the keyboard) in 
this window and click Open.   

IV.  Click OK in the Local Background Files window.   
V. Click on View->Layers->Background to change the color and appearance of the background 

file to differentiate it from the regular file that is open. The Background Layers window will 
open.   

VI. Double click on one of the features to open another window (with the name of the selected 
feature).   

VII. Select the symbol/line style for the feature and click OK.   
VIII. Select another feature by double clicking on it to change its appearance, if desired.   
IX.  When finished modifying the appearance of the features, click OK in the Background Layers 

window to display the background in the Map window. 
X. To remove the background in the Map window, go to File->Background and click Remove in 

the Local Background Files window. 
 

Quality Checking Individual Features 
 

I. In the Feature Properties window click First and then click the > (right arrow).  Clicking the 
> (right arrow) will scroll through the data in the order it was collected.  (It will probably be 
necessary to click the right arrow a couple of times before the first feature is selected).  The 
feature that is selected in the Feature Properties window will be highlighted in blue in both 
the Map window and the Time Line window. 
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II. Several items need to be inspected for each feature: 
A. Inspect all of the attributes in the Feature Properties window to ensure that the 

information was correctly entered for each feature.  (See below for instructions on 
changing attribute values). 

B. With the Summary tab selected at the bottom of the window, ensure that at least ten 
positions were collected for point features, a length is stated for line features, and an area is 
stated for area features.  If a “?” (question mark) exists for any of the features, no positions 
were collected for the feature; thus, the feature will not be spatially recognized (and will 
not show up on the map).  Delete any such feature.  (See below for instructions on deleting 
an entire feature.)  

C. Click on the   (magnifying glass with the plus sign icon) to zoom in on the feature that 
is being inspected in the Map window.  Look it over carefully and make sure that it looks 
correct.  Keep in mind the scale of the Map window.  The current scale can be found in the 
Map window’s title bar.  If the window is zoomed in to a very small scale (e.g. 1:100) most 
any feature will look inaccurate.  (Remember the accuracy for this project is two-to-five 

meters).  If necessary, use the  (hand icon, known as the pan tool) to pan to different 
parts of the map view to inspect the whole feature.  To pan with the pan tool, just click and 
drag the mouse across the Map window.  If it appears that a position is an outlier as 
compared to the location of the rest of the positions, the single position can be deleted.  
(See below for instructions on deleting individual positions.)   
Hints:  If the  (hand with the arrow in the middle icon) is selected, Pathfinder Office 
will automatically pan at the current map scale to the first position in the selected feature.  

The  (magnifying glass with the equals sign icon) will zoom the map back out to the 
full extent. 

Attribute 
Data for 
Selected 
Feature 

Click First to get to 
beginning of the 
feature list. Click these Arrows to Move 

Forward and Backward 
Through the Features 

Make Changes to the 
Attributes in this Box 
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III. After fully quality checking the first feature, click the > right arrow in the Feature Properties 
window and fully inspect the next feature. 

IV.  After reviewing all of the features within the file, close the file (click File->Close). 
V.  After quality checking the first file that was created, repeat all of these steps to quality check 

all of the files that were created.  
 

Changing Attribute Values 
 
If an attribute error is found while quality checking the data, changes can be made in the Feature 
Properties window.   
 
I. Click on the Attributes tab at the bottom of the window and then click on the erroneous 

attribute.   
II. A box at the bottom of the Feature Properties window will display the attributes contents.   
III. Within this box, the appropriate changes can be made to the attribute values.  The type of 

information that can be entered into an attribute is confined by the attribute-type specified in 
the data dictionary.  (e.g. The Section attribute is a menu-type attribute, therefore, only items 
contained in the menu can be entered as a value in this attribute.) 

IV.  To save the changes, click the >  (right arrow).  Pathfinder Office will open a new window 
prompting to save or discard the changes made to the feature. 

V. After saving the changes to the feature, the < (left arrow) may be used to return to the edited 
feature for inspection. 

 
Deleting an Entire Feature 

 
If a feature was unintentionally collected, incorrectly collected, or stored without logging any positions, 
it can be deleted out of the file.   
 
I. Use the > (right arrow) in the Feature Properties window to select the feature to be delete.   
II. Click Delete at the top of the Feature Properties window.   
III. Pathfinder Office will prompt, “Do you want to delete the current feature?”  Click Yes to delete 

the feature, or click No to cancel the deletion.  Delete will then change to Undelete showing 
that the feature has been deleted from the file.   

IV.  If the deletion was unintentional, click on Undelete to restore the feature.   
 

The feature, although deleted, will always remain in the file and can be restored at any time, even after 
saving and closing the file. 

Deleting Individual Positions within a Feature 
 

If incorrect positions were collected within a feature, the individual positions can be deleted.   
 

I. Click on the feature that has the apparent inaccurate position somewhere near that position in 
the Map window, or select the feature by using the > (right arrow) in the Feature Properties 
window.  Notice the blue “X” that appears on the feature that was selected.  The “X” marks an 
individual position within the feature.   
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II. Click the < (left arrow) or the > (right arrow) in the Position Properties window until the 
position that is to be deleted is indicated by the “X”.   

III. Click Delete in the Position Properties window to delete the individual position.  Notice that 
Pathfinder Office will then “snap” a straight line between the positions that remain just before 
and just after the position that was deleted.  The Delete button in the Position Properties 
window will change to Undelete showing that the position has been deleted.   

IV.  If the position was unintentionally deleted, click Undelete to restore it.   
 

The deleted position(s) will always remain in the feature and file, although they will not be used.  The 
position(s) can be restored even after saving and closing the file. 
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Data Transfer to CDOT HQ 
 

The data must now be transferred to CDOT Headquarters for further processing.  Pathfinder Office is 
not used for this process, and therefore, it does not need to be open. 
 
I. Make sure the computer is connected to the internet or to the local area network. 
II. Click on the Start button in the lower left corner of the screen. 
III. Go to Programs->Windows Explorer.  Windows Explorer will open. 
IV.  In the left part of the Windows Explorer window, click the “+” (plus symbol) next to Network 

Neighborhood.  
V. Click the “+” next to Entire Network. 
VI. Click the “+” next to CDOT HQ. 
VII. Click the “+” next to Weeds 1. 
VIII. Use the scroll bar in the left part of the Windows Explorer window, and scroll up until the 

(C:) drive is viewable.  Click the “+” next to (C:), then click the “+” next to Pfdata.   
IX.  Click on the folder (NOT the “+”) that contains the data that is to be transferred.  (The data may 

or may not be stored in the Pfdata folder.  Locate the folder where the data is stored and click 
on it.)  The list of files in the folder will appear in the right part of the Windows Explorer 
window. 

X. Select the files to be transferred in the right part of the window.  Only the corrected files (with 
the “target” icon) need to be transferred.  To select multiple files, hold down on the Ctrl key on 
the computer keyboard while clicking on the files. 

XI. Scroll back down to the Weeds 1 folder in the left part of the Windows Explorer window.  
Drag the selected files in the right part of the window until the cursor is over the name of the 
Section where the data was collected.  When the mouse button is released, the file transfer will 
begin. 

 
Transferring the files to the Weeds 1 folder creates a copy of the file on a computer at CDOT 
Headquarters.  A copy of the original file will remain on the computer from which it was transferred.  
This file should be retained in case an unrecognized transfer error or other problem occurred.  It is 
important that the individual collecting the data keeps a copy of the file. 
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Deleting Files from the GeoExplorer 3 
 

Delete the files off of the GeoExplorer 3 to help keep the data organized and to free up the memory on 
the GeoExplorer 3 after the Pathfinder Office processes have been completed.   
 
Note:  Do not delete the files off of the computer; only delete the files off of the GeoExplorer 3 after all 
of the processes have been completed. 

 
I. Turn on the GeoExplorer 3. 
II. Press the Data Button. 
III. Press the Option Button. 
IV.  Select Delete file(s) from the window. 
V. Press ENTER on the file you wish to delete. 
VI. Confirm deletion. 
VII. Repeat until all files that are no longer needed and fully post-processed have been deleted. 
VIII. Shut down the GeoExplorer 3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
________________________________________________________________________ 
 
Trimble, GeoExplorer, and Pathfinder Office are registered trademarks of Trimble Navigation Limited.



Appendix A – GPS Field and Computer Procedures Manual 

 

 
Appendix A - Weed Phenology 

 
Scientific Name Common Name Phenology 
Acroptilon repens 
(= Centaurea repens) 

Russian knapweed flowering June - Oct.; 
does not reproduce extensively from 
seed 

Aegilops cylindrica  
(= Cylindropyrum cylindricum) 

jointed goatgrass flowering early to mid-June; shed 
seeds June - July 

* Alhagi pseudalhagi  
(= Alhagi camelorum) 

camelthorn flowering June;  
produces seed July 

Cardaria draba hoary cress flowering May - June; 
set seed mid-summer 

Carduus nutans ssp. macrolepsis musk thistle flowering late May/early June - mid 
July; seed matures 1-3 weeks after 
flowering  

Centaurea diffusa  
(= Acosta diffusa) 

diffuse knapweed flowering July - Aug.; 
seed matures mid Aug. 

Centaurea maculosa  
(= Acosta maculosa) 

spotted knapweed flowering Aug. - Sept.; 

* Centaurea solstitialis yellow starthistle flowering June - Aug.; 
Cirsium arvense  
(= Breea arvense) 

Canada thistle flowering June - Oct.; seed matures 
July - Oct. 

Convolvulus arvensis field bindweed flowering June - Sept./until frost; seed 
matures w/in 2 wks. after pollination 

Cynoglossum officinale houndstongue flowering Aug.; 
Euphorbia esula 
(= Tithymalus esula) 

leafy spurge flowering May - late June/mid-July; 
seed matures 30 days after pollination 

* Hieracium aurantiacum orange hawkweed flowering June - July; quickly produce 
seed 

Lepidium latifolium perennial  
pepperweed 

flowering June- Aug.; 

* Lespedeza sp.  information is needed on which 
species is of concern in Colorado 

Linaria dalmatica  
(= Linaria genistifolia ssp.    
dalmatica) 

Dalmatian toadflax flowering May - Aug.; 
seed matures July - Sept. 

Linaria vulgaris yellow toadflax flowering May - Aug.; 
seed matures July - Oct. 

* Peganum harmala African rue perennial herb 
* = new incoming species 
References: 2000.  Creating an Integrated Weed Management Plan. CNAP; personal communication with CNHP 
Botanist Susan Spackman; 1996. Weeds of the West; 1990. Zimdahl. Weeds of Colorado. Cooperative Extension 
Bulletin 521A. 
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__________________________________________________ 
INTRODUCTION 

    
   The State of Colorado has recognized ten species of noxious weeds as a 
top priority in its weed management plan.  The Colorado Department of 
Transportation contracted the Colorado Natural Heritage Program to 
develop Weed Fact Sheets for these top ten species. The fact sheets have 
been designed to aid in the identification and subsequent control of these 
top ten noxious weed species. Included with the fact sheets are a glossary 
of botanical terms and a list of references.  
__________________________________________________ 
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photographers are acknowledged throughout the text. 
    Illustrations of Cardaria draba and Euphorbia esula by W.L. Stump  
were reproduced with permission from Colorado State University, 
Cooperative Extension, Weeds of Colorado, Bulletin 521A, 1998, Robert 
L. Zimdahl.  Illustrations of Carduus nutans, Centaurea diffusa, Centaurea 
repens, Cirsium arvense, Convolvulus arvensis, Cynoglossum officinale, 
Linaria dalmatica, and Linaria vulgaris were reprinted with permission 
from Vascular Plants of the Pacific Northwest, copyright circa 1969, 
University of Washington Press.   
    Photographs of Centaurea diffusa, Centaurea repens, Convolvulus 
arvensis, Cynoglossum officinale, and Linaria dalmatica were reproduced 
with permission from the Colorado Weed Management Association web 
site cwma.org.  Photographs of Carduus nutans, Centaurea diffusa, 
Centaurea repens, Linaria dalmatica, and Linaria vulgaris were 
reproduced with permission from Weeds of the West, Tom Whitson ed., 
copyright 2000, University of Wyoming.  David G. Anderson and Peggy 
Lyon of the Colorado Natural Heritage Program provided additional 
photos. 
    The Colorado Department of Transportation provided funds to produce 
these fact sheets.   
    We appreciate the input of our technical reviewers Susan Spackman and 
Georgia Doyle.  



 
ADDITIONAL ACKNOWLEDGMENTS                           
                           
Illustrations of Elaeagnus angustifolia, Hieracuim aurantiacum, and 
Hyoscyamus niger courtesy of USDA- NRCS PLANTS Database, Version 
3.5 (http://plants.usda.gov).  Illustrations of Carduus acanthoides, 
Centaurea solstitialis, Clematis orientalis, Hesperius matronalis, and 
Tamarix ramosissima  were reprinted with permission from the Colorado 
Natural Areas Program publication Creating an Integrated Weed 
Management Plan. Illustrations of Chrysanthemum leucanthemum by 
Regina O. Hughes and Lythrum salicaria by W.L. Stump were reproduced 
with permission from Colorado State University, Cooperative Extension, 
Weeds of Colorado, Bulletin 521 A, 1998, Robert L. Zimdahl. 
www.cerc.colostate.edu/titles/521A.html.  
 
Photographs of Carduus acanthoides, Centaurea solstitialis, 
Chrysanthemum leucanthemum, Elaeagnus angustifolia, Hieracium 
aurantiacum, Hyoscyamus niger, Lythrum salicaria, and Tamarix 
ramosissima were reproduced with permission from Weeds of the West, 
Tom Whitson ed., copyright 2000, University of Wyoming. Photographs 
of  
Clematis orientalis and Carduus acanthoides  provided by David G. 
Anderson of the Colorado Natural Heritage Program. Steve Anthony, 
Vegetation Management, Garfield County provided the photographs of 
Hesperius matronalis . 
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Federal Center, Denver, CO. 318 p. 
 
Photographs of Eriogonum clavellatum courtesy of James L. Reveal and 
USDA- NRCS PLANTS Database, Version 3.5 (http://plants.usda.gov). 
 
We appreciate the input of our technical reviewers David Anderson, Lee 
Grunau and Joe Stevens.  
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COLORADO NOXIOUS WEED 
 
BLACK HENBANE                                   Hyoscyamus niger 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Identifying characteristics: Flowers brownish-yellow or greenish-yellow 
with purple veins and purple center, occurring on elongated racemes where 
the stem joins the upper leaves; leaves alternate and short stalked, upper 
leaves may lack stalk entirely, shallowly lobed to coarsely toothed, and 
covered with fine hair; rosette leaves pubescent and serrated; foliage has a 
foul odor; plants 1-3 ft. tall; annual or biennial. 
 

Solanaceae (Nightshade Family) 
 

Look alikes: None known. Only Hyoscyamus species in Colorado.  
Flowering/Fruiting Period: June-September. 
Distribution: European native; grown as an ornamental and now widely 
distributed throughout most of North America. Locally common along the 
Front Range and Western Slope of Colorado. 
Habitat: Roadsides, pastures, fencerows, riparian areas and waste areas. 
Elevation up to approximately 9000 ft. 

 



References: CNAP 2000; Cronquist et al. 1994; Harrington 1954; Whitson 
et al. 2000. 
 
  
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
    Black henbane plant and rosette courtesy of Weeds  
 of the West  
 

 
 
 
 
 
  
 
 

 

 



 
 
 

COLORADO NOXIOUS WEED 
 
BULL THISTLE                        Cirsium vulgare 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
Identifying characteristics:  Flowers pinkish to dark purple, clustered at 
the ends of branches, bracts are spiny; leaves alternate with stiff, prickly 
hairs above, cottony hairs below, pinnately lobed and tipped with stout 
needlelike spines; leaves extend down, clasping the stem, giving the 
appearance of spiny wings; plants 2-5 ft. tall, with many spreading 
branches; taprooted biennial.  
 

Asteraceae (Aster Family) 
 

Look alikes: Bull thistle can be distinguished from other non-native 
thistles by flower size, bract appearance, and leaf surfaces.  In rosette form 
it can be readily distinguished by the prickly upper surface of its leaves.  
The native thistles generally do not have leaves clasping the stems all the 

 

 



way from node to node, and their leaves are hairier and lighter green/blue 
to gray in color. 
Flowering/Fruiting Period: July -September. 
Distribution: Native to Eurasia; introduced and widespread throughout 
North America.  In Colorado it is known from the Front Range, and 
throughout the Western Slope. 
Habitat: Roadsides, fields, pastures and other disturbed areas.  Elevation 
5000-10,800 ft. 
References: CNAP 2000; Cronquist et al. 1994; Hitchcock et al. 1969; 
Whitson et al. 2000; Zimdahl 1998. 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
    Bull thistle plant and rosette courtesy of Weeds of the West 
 
 
 
 
 

 

 



COLORADO NOXIOUS WEED 
 
CANADA THISTLE                       Cirsium arvense 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 

 
Identifying characteristics:  Flowers pink-purple or occasionally white, 
borne in clusters of 1-5 per branch; leaves are spiny, alternate, oblong or 
lance-shaped, with the base leaves stalkless and clasping, or extended 
down along the spiny stem, plants 1-5 ft. tall, single stemmed, 
rhizomatous; perennial.  
 

Asteraceae (Aster Family) 
 

Synonym: Breea arvensis  
Look alikes: All thistles look somewhat alike, especially the basal rosettes.  
Most other thistles have larger flowers and do not have the rhizomatous 
growth form. Cirsium flodmanii, a native thistle, which is uncommon in 
eastern Colorado, is also rhizomatous and, like C. arvense, forms patches 
in wet areas.  C. flodmanii leaves are very white and pubescent below and 
shiny green on top. Canada thistle is comparatively darker.  Most native 
thistle leaves and stems are more hairy and lighter green/blue in color. 
Flowering/Fruiting Period: June-October. 

 



Distribution: Native to Eurasia; introduced and widespread throughout the 
United States and southern Canada.  Known from most Colorado counties. 
Habitat: Roadsides, fields, ditches, pastures and other disturbed areas.  
Elevation 4000-10,000 ft. 
References: CNAP 2000; CNHP 2002;  Cronquist et al. 1984; CWMA 
2000; Hitchcock et al. 1969; Whitson et al. 2000. 
 
   

 

    
Rosette of Canada thistle by David G. 
Anderson 

 

                
             Canada thistle by Peggy Lyon 
  



COLORADO NOXIOUS WEED 
 
CHINESE CLEMATIS                      Clematis orientalis 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
Identifying characteristics:  Flowers solitary with four yellow sepals, 
often nodding, lightly scented; fruits conspicuous with feathery long-tailed 
seeds; leaves opposite, usually with three thin, coarsely toothed leaflets; 
stems herbaceous to woody, climbing up to 10 ft.; plants herbaceous 
perennial to woody vine.  
 

Ranunculaceae (Buttercup Family) 
 

Synonym:  C. aurea, Viticella orientalis 
Look alikes:  The native Clematis ligusticifolia is distinguished by its 
white-sepaled flowers that are borne in clusters. 
Flowering/Fruiting Period: July -September. 
Distribution: Native to Eurasia; introduced and becoming naturalized in 
several western states including Colorado, Utah, Idaho, Nevada and New 
Mexico. In Colorado, it is found in the south and central parts of the state. 
Habitat: Sagebrush, mountain shrublands, and disturbed areas such as  
roadsides and stream valleys.  Elevation 6000-8000 ft. 

 



References: CNAP 2000; Harrington 1954; USDA-NRCS 2004; Weber 
and Wittman 2001. 
 
 
 
 
   

 

                
     
     Chinese clematis plant and flower/fruit by David G. Anderson      
                
       

       
       
 
 
 



COLORADO NOXIOUS WEED 
 
DALMATION  TOADFLAX            Linaria dalmatica 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Identifying characteristics:  Flowers yellow, resembling snapdragons, 
occurring in terminal, elongated racemes; leaves are waxy, alternate, broad, 
ovate, crowded with upper leaves clasping the stem; stems 1-25 per plant, 
somewhat woody, clumps of stems can be up to 3 ft. tall; perennial.  
 

Scrophulariaceae (Figwort Family) 
 
Synonym: Linaria genistifolia ssp. dalmatica 
Look alikes: The exotic yellow toadflax (Linaria vulgaris) is similar in 
appearance and can be distinguished by its more narrow and linear pointed 
leaves. 
Flowering/Fruiting Period: May-September. 
Distribution: Native to the Mediterranean region; introduced and scattered 
throughout the western United States, less frequent in the eastern states. 
Known from scattered locations throughout Colorado. 
Habitat: Roadsides, rangelands and riparian areas.  Elevation 5000-6500 
ft., occasionally up to 9000 ft. 
 

             



 
 
References: CNAP 2000; CNHP 2002;  Cronquist et al. 1994; CWMA 
2002; Hitchcock et al. 1969; Whitson et al. 2000; Zimdahl 1998. 
 

                                     Dalmation toadflax courtesy of the Colorado  
                           Weed Management Association 

 

           Vegetative dalmation toadflax 
        courtesy of Weeds of the West 



COLORADO NOXIOUS WEED 
 
DAME'S ROCKET                              Hesperius matronalis  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
Identifying characteristics:  Flowers white to pink or purple with four 
petals and a sweet fragrance, clustered in terminal stalks; leaves alternate, 
lance shaped with finely toothed margins; stems herbaceous ranging in size 
from 1 to 4 ft.; biennial or short-lived perennial.  
 

Brassicaceae (Mustard Family) 
 
Look alikes:  Scent and flower color distinguish this species from native 
mustards that are predominately white or yellow with an unpleasant odor 
or odorless. 
Flowering/Fruiting Period: May-July. 
Distribution: Native to Europe; introduced as an ornamental and 
becoming established in the northern United States.  In Colorado, it is 
found in several Front Range counties, including the Boulder foothills, and 
on the West Slope in Pitkin, San Miguel and Gunnison counties. 
Habitat: Moist, partly shaded woodlands, ditches, roadsides, pastures and 
rangelands.  Elevation up to 8100 ft. 

       
 



References: CNAP 2000; CWMA 2004; USDA-NRCS 2004; Weber and 
Wittman 2001. 
 
 
 
 
   

 

 
 
Dame's rocket plant and flowers courtesy of Steve Anthony 
 

 
 
 



COLORADO NOXIOUS WEED 
 
DIFFUSE KNAPWEED            Centaurea diffusa 

 
 
Identifying characteristics: Flowers white or lavender, solitary or in 
clusters of 2-3 at the ends of branches; bracts appear fringed or teethed, 
ending in a slender spine; leaves are pinnately divided, alternate, becoming 
smaller, mostly entire and bract-like near the flower clusters; stems are 
rough to the touch; plants 1-2 ft. tall, diffusely branched; annual or short- 
lived perennial.  
 

Asteraceae (Aster Family) 
 

Synonym: Acosta diffusa 
Look alikes: Diffuse knapweed may resemble other knapweeds, 
particularly spotted knapweed.  Diffuse knapweed can be distinguished by 
the sharp spine found at the end of the bracts. 
Flowering/Fruiting Period: July -August. 



Distribution: Native to the eastern Mediterranean region; introduced and 
scattered throughout the United States.  Known from most Front Range 
counties, and scattered locations on the east and west slope. 
Habitat: Roadsides, dry rangelands and other disturbed areas; does not 
tolerate cultivation or excessive moisture.  Elevation up to 8500 ft. 
References: CNAP 2000; CNHP 2002;  Cronquist et al. 1984; CWMA 
2002; Hitchcock et al. 1969; Whitson et al. 2000. 
 

                 Diffuse knapweed courtesy of the Colorado Weed 
            Management Association 

 

 
Rosette of diffuse knapweed courtesy of 
Weeds of the West  

 



COLORADO NOXIOUS WEED 
 
FIELD BINDWEED                   Convolvulus arvensis 

 
 
Identifying characteristics: Flowers white to pink, bell or trumpet 
shaped, about 1 inch in diameter, with two small bracts about 1 inch below 
the flower; leaves are alternate, simple, 1-2 inches long, and somewhat 
arrowhead shaped with spreading, pointed, or blunt lobes at the base; stems 
are prostrate, 1-4 ft. long, often climbing or forming dense mats; plants 
have an extensive root system; perennial.  
 

Convolvulaceae (Morningglory Family) 
 

Look alikes: The introduced black bindweed (Fallopia convolvulus) in the 
Buckwheat family is similar.  The native hedge bindweed (Calystegia 
sepium) can be distinguished from field bindweed by its larger leaves and 
flowers. 
Flowering/Fruiting Period: June-September. 

           
 

 



Distribution: Native to Europe; introduced and widespread throughout the 
United States. Common throughout Colorado. 
Habitat: Cultivated areas, fields, pastures, gardens, lawns, roadsides and 
waste areas. Elevation 4000-8000 ft., but can be found up to 10,000 ft. 
References: CNAP 2000; CNHP 2002;  Cronquist et al. 1994; CWMA 
2002; Hitchcock et al. 1969; Whitson et al. 2000; Zimdahl 1998. 
 

                    
                            Field bindweed courtesy of Colorado Weed 
                            Management Association 

                                     Seedling of field bindweed by David G.  
                           Anderson 

 



COLORADO NOXIOUS WEED 
 
HOARY CRESS                                        Cardaria draba 

Identifying characteristics: Flowers white with four petals, the numerous 
flowers give the plant a flat, white-topped appearance; leaves are alternate, 
0.5-2 inches long, blue-green to gray-white in color, lance shaped, upper 
leaves have basal lobes which clasp the stem; stems are erect, up to 2 ft. 
tall; perennial. 
 

Brassicaceae (Mustard Family) 
 

Look alikes: Two exotic species of mustard (Cardaria pubescens and 
Cardaria chalepensis), which are also designated as noxious weeds in 
some states, look similar.  The rosettes of the native gumweed (Grindelia 
squarrosa) are similar, and found in similar habitats. 
Flowering/Fruiting Period: May-July. 
Distribution: Native to Asia; introduced from Europe and widespread in 
the United States, except for the southern portion of the south-central and 
western states; common throughout the lower elevations of Colorado. 

           
 
 

                                             



Habitat:  Roadsides, meadows, pastures, cropland, and disturbed areas; 
grows well on alkaline soils with moderate rainfall. Elevation 3500-8500 
ft. 
References: CNAP 2000; CNHP 2002; CWMA 2002; Whitson et al. 
2000; Zimdahl 1998. 
 
           

                  
Hoary cress by David G. Anderson 

 

                                       Hoary cress rosettes by David G. Anderson      
 



COLORADO NOXIOUS WEED 
 
HOUNDSTONGUE               Cynoglossum officinale 

 
Identifying characteristics: Flowers reddish-purple, with five petals, and 
occur in long, sometimes branched, terminal clusters; leaves are alternate, 
1-12 inches long, 1-3 inches wide, rough, hairy, and lacking teeth or lobes; 
stems are erect, stout, heavy, 1.5-3 ft. tall; the entire plant is covered with 
soft white hairs; biennial or short-lived perennial. 
 

Boraginaceae (Borage Family) 
 

Look alikes: The rosettes of houndstongue may resemble the exotic 
burdock (Arctium genus) in the Aster family, and when not flowering it 
may also resemble some of the native stickseeds (Hackelia or Lappula 
genus). Flowering plants are not likely to be confused with other species. 
Flowering/Fruiting Period: May-July. 
Distribution: Native to Asia; introduced from Europe, and well 
established throughout the United States; found throughout Colorado. 

           
 
 

                       



Habitat:  Rangeland, roadsides, pastures, abandoned cropland, and waste 
areas. Elevation 5000-9000 ft. 
References: CNAP 2000; CNHP 2002;  Cronquist et al. 1994; CWMA 
2002; Hitchcock et al. 1969; Whitson et al. 2000; Zimdahl 1998. 
 

                                           Houndstongue courtesy of Colorado Weed  
                                Management Association 

                  
              Houndstongue rosette by David G. Anderson  



COLORADO NOXIOUS WEED 
 
JOINTED GOATGRASS                     Aegilops cylindrica 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
Identifying characteristics:  Seed head a 2-4 inch cylindrical, balanced 
spike with 5-10 spikelets (joints) per spike; leaves are alternate, simple, 
1/8-1/4 inch wide with hairs; mature plants 15-30 inches tall with one to 
many erect stems; short, fibrous root system; winter annual grass.  
 

Poaceae (Grass Family) 
 

Synonym:  Cylindropyrum cylindricum 
Look alikes: Similar in appearance, and genetically related to winter 
wheat. 
Flowering/Fruiting Period: June-July. 
Distribution: Native to southern Europe; introduced from Turkey, and 
established in the winter wheat growing areas of North America.  Common 
in the dryland areas of Eastern Colorado. 
Habitat: Wheat fields, roadsides, waste areas, fields, and pastures.  
Elevations up to 6000 ft. 
References: CNAP 2000; Cronquist et al. 1994; Hitchcock et al. 1969; 
Whitson et al. 2000; Zimdahl 1998. 

 

 



 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
                 
 
 
 
    Jointed goatgr ass plant and seedling courtesy of Weeds of the West         

 
                                                                                  
 
 
 
 
 
 
 
  
 

 

 



COLORADO NOXIOUS WEED 
 
LEAFY SPURGE                           Euphorbia esula 

 
Identifying characteristics: Flowers yellowish-green, small, arranged in 
numerous small clusters with a pair of heart shaped yellow-green bracts 
below each flower; leaves are alternate, narrow with smooth margins, 1-4 
inches long; stems are unbranched and typically clustered together; plants 
up to 3 ft. tall, the entire plant contains a milky latex; perennial.  
 

Euphorbiaceae (Spurge Family) 
 

Synonym: Tithymalus esula 
Look alikes: Leafy spurge may be distinguished from native spurges such 
as Euphorbia brachycera  by its long linear leaves. 
Flowering/Fruiting Period: May-July. 
Distribution: Native to Eurasia; introduced and widely scattered 
throughout the United States. Common in Colorado in disturbed areas. 

            
 



Habitat: Roadsides, fields, pastures, riverbanks, irrigation ditches and 
other disturbed areas. Elevation 5000-6500 ft., but can be found up to 9000 
ft. 
References: CNAP 2000; CNHP 2002;  CWMA 2002; Whitson et al. 
2000; Zimdahl 1998. 
                       
              

Leafy spurge by David G. Anderson 

 

     Vegetative leafy spurge by David G. 
   Anderson 

 



COLORADO NOXIOUS WEED 
 
MUSK THISTLE                        Carduus nutans 

 
Identifying characteristics:  Flowers purple or occasionally white, 
terminal, solitary and usually nodding; bracts broad, spine tipped; leaves 
elliptical to lanceolate, dark green, deeply lobed with light green mid-rib 
and mostly white margins; leaves extend onto stem giving a winged 
appearance; plants up to 6 ft. tall, usually single stemmed, highly branched 
above; winter annual or biennial.  
 

Asteraceae (Aster Family) 
 

Look alikes: All thistles look somewhat alike, especially the basal rosettes.  
Most native thistle leaves and stems are hairier, lighter green/blue in color, 
and do not have leaves clasping the stem all the way from node to node.  
Flowering/Fruiting Period: Late May-July. 
Distribution: Native to Eurasia; introduced and widespread throughout the 
United States and southern Canada.  Known from most Colorado counties. 
Habitat: Roadsides, fields, ditches, pastures and other disturbed areas.  
Elevation 4000-10,000 ft. 

 
 
 
 
 
 
 
 
 



References: CNAP 2000; CNHP 2002;  Cronquist et al. 1984; CWMA 
2002; Hitchcock et al. 1969, Whitson et al. 2000. 
 

 

 
Musk thistle by Peggy Lyon 

 

                                       Rosette of musk  thistle courtesy of 
                            Weeds of the West 
                               



COLORADO NOXIOUS WEED 
 
ORANGE HAWKWEED             Hieracium aurantiacum     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
Identifying characteristics:  Flowers orange-red with notched tips, in 
clusters of 5-30 at the top of leafless stems; leaves basal with small stiff 
hairs; stems 6-18 inches tall with bristly hairs; fibrous roots with stolons, 
often rooting at the nodes; perennial.  
 

Asteraceae (Aster Family) 
 
Look alikes:  Two exotic species of yellow hawkweed Hieracium pratense 
and H. pilosella are similar, but are not known to occur in Colorado. 
Native hawkweeds (Chlorocrepis spp .) and false dandelions (Agoseris 
spp.) are also similar in appearance. 
Flowering/Fruiting Period: June-July. 
Distribution: Native to Europe; established in the northern United States.  
In Colorado, it is known from Douglas, Jefferson, Eagle and Pitkin 
counties, and Rocky Mountain National Park. 
Habitat: Mountain meadows, or other open areas such as pastures and 
hayfields. Elevation 5000-10,500 ft. 

      
 



References: CNAP 2000; CWMA 2004; USDA-NRCS 2004; Whitson et 
al.2000. 
 
 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 Orange hawkweed plant and leaf courtesy of Weeds of the West  

 

 



COLORADO NOXIOUS WEED 
 
OXEYE DAISY                   Chrysanthemum leucanthemum 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Identifying characteristics:  Flowers solitary heads with white ray 
flowers and yellow disc flowers, approximately 2 inches in diameter, with 
a cluster of bracts at the base of each flower head; leaves alternate, smooth 
to slightly hairy, basal and lower leaves lance shaped to narrowly egg 
shaped, toothed or lobed, 2-5 inches in length; upper leaves become 
smaller and stalkless with slightly toothed to entire margins; stems erect, 
12-24 inches tall; plants have fairly well developed rhizomes; perennial.   
 

Asteraceae (Aster Family) 
 

Synonym:  Leucanthemum vulgare 
Look alikes: Often confused with the ornamental Shasta daisy 
(Chrysanthemum maximum). Can be differentiated by the Shasta daisy’s 
more robust appearance and larger flowers.  
Flowering/Fruiting Period: June-September. 

 



Distribution: Native to Europe; introduced as an ornamental and now 
occurs throughout North America. Found in disturbed, moist areas of 
Colorado. 
Habitat: Roadsides, meadows and disturbed areas; grows best in fairly 
moist areas. Elevation up to approximately 10,000 ft.  
References: CNAP 2000; Cronquist et al. 1994; Whitson et al. 2000; 
Zimdahl 1998. 
 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

               Oxeye daisy plant and flower head courtesy of Weeds of the West  
 

 
 
 
 
 
 
 
 
 
 
 
  
 

 

 



COLORADO NOXIOUS WEED 
 
PERENNIAL PEPPERWEED               Lepidium latifolium 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 

 
Identifying characteristics:  Flowers white, in dense clusters at the ends 
of branches; leaves alternate, lance shaped, entire to toothed, and do not 
clasp the stem, basal leaves larger than upper leaves, leaves and stems 
covered with a waxy layer; plants 1-3 ft. tall; deep-rooted perennial. 
 

Brassicaceae (Mustard Family) 
 

Look alikes:  Whitetop (Cardaria draba) is similar in appearance, and 
may be distinguished by it’s clasping leaves.  Many native sunflowers 
(Asteraceae) resemble perennial pepperweed in the rosette stage. 
Flowering/Fruiting Period: Mid -May-August. 
Distribution: Native to Eurasia; introduced and widespread throughout 
North America.  Found throughout Colorado, particularly the San Luis 
Valley and along the South Platte River. 
Habitat: Roadsides, riparian areas, ditches, and seasonally wet areas.  
Elevation 5500-9000 ft. 
References: CNAP 2000; Whitson et al. 2000; Zimdahl 1998. 
 
 

 

 



 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
     
 
 
 
  
                      Perennial pepperweed plant and rosette courtesy of  
                      Weeds of the West 

 



COLORADO NOXIOUS WEED 
 
PLUMELESS THISTLE                 Carduus acanthoides 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
Identifying characteristics:  Flowers pink-purple or occasionally white or 
yellowish, solitary or in clusters of 2-5 at the end of branches; basal rosette 
leaves 4-8 inches long with spiny lobes, stem leaves alternate, hairy below, 
and stalkless clasping the stem; stems freely branched, covered with leaf-
like spiny wings up to the flower heads; plants 1-4 ft. tall, with a fleshy 
taproot; winter annual or biennial.  
 

Asteraceae (Aster Family) 
 

Look alikes: All thistles look somewhat alike, especially the basal rosettes.  
Plumeless thistle is most similar to the exotic musk thistle, and can be 
distinguished by its smaller flowers, and lack of a prominent white margin 
on its leaves.  Most native thistle do not have leaves clasping the stem from 
node to node, and the leaves and stems are hairier and lighter green/blue in 
color. 
Flowering/Fruiting Period: May-August. 
Distribution: Native to Eurasia; introduced and becoming established in 
the Great Plains and Intermountain West of the United States.  Frequently 

 



found in Colorado, it has the potential to become widespread, particularly 
in the northwestern portion of the state. 
Habitat: Roadsides, pastures, fields, and stream valleys.  Elevation 4000-
9000 ft. 
References: Anthony 2004; CNAP 2000; CWMA 2004; Whitson et al. 
2001. 
 
   

 
                

           
          Plumeless thistle plant by David G. Anderson 
    

   

 
Rosette of plumeless thistle courtesy of Weeds of  the West  
the West  



COLORADO NOXIOUS WEED 
 
PURPLE LOOSESTRIFE                        Lythrum salicaria    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
Identifying characteristics:  Flowers rose-purple in long, terminal 
racemes; leaves simple, entire, and whorled or opposite; stems erect, 6-8 ft 
tall, and square in the cross section (particularly the lower sections); plants 
have a taproot and short rhizomes; perennial.  
 

Lythraceae (Loosestrife Family) 
 
Look alikes:  May be confused with the exotic mustard Dame's rocket 
(Hesperis matronalis) or the native fireweed (Chamerion spp.), both of 
which have four-petaled flowers. 
Flowering/Fruiting Period: June-September. 
Distribution: Native of Eurasia; well established in the United States.  In 
Colorado, it is known from the Front Range, and also from the West Slope 
counties of Mesa, Montrose and Otero. 
Habitat: Wet sites such as the margins of ditches, canals or streams, 
marshes, wet meadows, and the shorelines of shallow ponds and wetlands.  
Elevation 3500 ft. or more, upper limits unknown. 
 

      
 



 
References: CNAP 2000; DiTomaso and Healy 2003; USDA -NRCS 2004; 
Whitson et al.2000; Zimdahl 1998. 
 
 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Purple loosestrife plant and leaves courtesy of Weeds of the West  
 

 

 
 



COLORADO NOXIOUS WEED 
 
RUSSIAN KNAPWEED            Centaurea repens 

 
Identifying characteristics: Flowers pink or purple, solitary at the tips of 
branchlets; bracts are broad, ovoid, entire, and greenish at the base with 
papery, finely hairy edges; leaves are alternate, oblong to lance-shaped and 
deeply lobed, upper leaves entire or serrated and progressively smaller in 
size; stems are covered with soft, short, gray hair when young; thin, stiff 
and branched at maturity; plants 1.5-3 ft. tall, forming dense colonies from 
adventitious shoots of the widely spreading black roots;  perennial.  
 

Asteraceae (Aster Family) 
 

Synonym: Acroptilon repens 
Look alikes: Russian knapweed can be distinguished from other 
knapweeds by the pointed, papery tips of the floral bracts.  The rosettes of 
Russian knapweed resemble some native members of the Aster family.   
Flowering/Fruiting Period: June-September. 

                
 



 
Distribution: Native to Eurasia; introduced and widely established 
throughout the western United States. Widespread in southwestern 
Colorado, and scattered elsewhere in the state. 
Habitat: Roadsides, fields, pastures, riverbanks, irrigation ditches and 
other disturbed areas. Elevation 4500-7500 ft. 
References: CNAP 2000; CNHP 2002;  Cronquist et al. 1984; CWMA 
2002; Hitchcock et al. 1969; Whitson et al. 2000. 
                       

 
Russian knapweed courtesy of the Colorado Weed 
Management Association 

         

                   Russian knapweed rosette courtesy of Weeds 
             of the West  



COLORADO NOXIOUS WEED 
 
RUSSIAN OLIVE                              Elaeagnus angustifolia 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Identifying characteristics:  Flowers yellow, occurring in umbel like 
clusters, sepals united and bell shaped, petals absent; leaves alternate, 
entire, lance shaped, 2-3 inches in length, and silvery in appearance, 
especially on underside of leaves due to very small scales; mostly reddish-
brown trunks and branches with 1-2 inch thorns; shrub or tree up to 25 ft. 
in height; deciduous. 
 

Elaeagnaceae (Oleaster Family) 
  
Look alikes: Elaeagnus commutata is a native North American species. It 
can be distinguished from E. angustifolia by the brown scales, lack of 
spines on the branches, wider leaves, and smaller shrub form. Russian 
olive may also resemble some willow (Salix) species. On the Western 
Slope, it may also be confused with Shepherdia argentea. 
Flowering/Fruiting Period: May-September.  
Distribution: European origin; introduced and cultivated in North 
America as an ornamental shade tree and for windrows. It is scattered 
throughout agricultural areas and along drainages in Colorado. 

 



Habitat: Creeks, streams, valleys, grasslands, roadsides, fencerows, and 
low-lying pastures. Elevation 4500-6500 ft.  
References: DiTomaso and Healy 2003;  Harrington 1954; Hitchcock and 
Cronquist 1973; USDA-NRCS 2004; Whitson et al. 2000. 
 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
                      Russian-olive tree and branch courtesy of Weeds of the West  
 
 
 
 
 
 
 
 
 
  
 

 

 



COLORADO NOXIOUS WEED 
 
SALTCEDAR                                       Tamarix ramosissima 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Identifying characteristics:  Flowers pinkish to whitish with 5 petals, 
arranged on narrow racemes 0.75-2 inches in length, in terminal finger-like 
clusters; leaves alternate, bluish-green, very small, with scales; stems 
highly branched and reddish-brown in appearance; roots deep, 100 ft. or 
more, and may spread horizontally up to approximately 150 ft. at water 
table depth; deciduous or evergreen, occurs as a shrub or small tree, up to 
20 ft. in height.  
 

Tamariaceae (Tamarisk Family) 
 
Look alikes: The introduced Eurasian small flowered tamarisk (Tamarisk 
parviflora) is similar in appearance. It can be distinguished from T. 
ramosissima  by its darker, purple to brownish colored bark and 4 petaled 
flowers.  
Flowering/Fruiting Period: April-August. 
Distribution: Native to Europe; introduced as an ornamental, it is now 
naturalized and spreading throughout the United States. In Colorado it is 
very common in riparian areas. 

 



Habitat: Riparian areas; flood plains, marshes, riverbanks, stream 
channels, and irrigation ditches. Tolerates very saline habitats and can also 
be found in salt flats; does not tolerate shade. Elevation 3400-7000 ft.  
References: CNAP 2000; DiTomaso and Healy 2003; Whitson et al. 2000. 
 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
                     
 
 
 
 
 
 
 
                  Saltcedar tree and flower courtesy of Weeds of the West  
 
 
 

 

 



COLORADO NOXIOUS WEED 
 
SCOTCH THISTLE                           Onopordum acanthium 

 
 
 
Identifying characteristics:  Flowers violet purple to reddish, flower 
heads numerous with spine-tipped bracts; leaves alternate, large, 
irregularly lobed with sharp spikes, rosette leaves up to 2 ft. long and 1 ft. 
wide, upper and lower leaf surfaces covered with a thick mat of cottony 
hairs, giving the plant a gray-green color; stems numerous, with broad 
spiny wings; plants up to 12 ft. tall with a fleshy taproot; biennial.  
 

Asteraceae (Aster Family) 
 

Look alikes: The native thistles generally do not have leaves clasping the 
stems all the way from node to node, and their leaves are hairier and lighter 
green/blue to gray in color. 
Flowering/Fruiting Period: June-Septemb er. 
Distribution: Native to Eurasia; introduced and occurs sparsely 
throughout North America.  It is increasing throughout Colorado. 
Habitat: Roadsides, irrigation ditches, and other disturbed areas.  
Elevation 5000-8000 ft. 
References: CNAP 2000; Cronquis t et al. 1994; Hitchcock et al. 1969; 
Whitson et al. 2000; Zimdahl 1998. 

 



 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
             Scotch thistle plant and rosette courtesy of Weeds of the West  
 
 
 
 
 
 
 
 
 
 
 
 
  
 

 

 



COLORADO NOXIOUS WEED 
 
SPOTTED KNAPWEED                       Centaurea maculosa 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Identifying characteristics:  Flowers pinkish-purple or rarely white, 
solitary at ends of branches, bracts are stiff and tipped with a black comb -
like fringe; leaves alternate, pinnately divided, becoming smaller towards 
the top of the shoot; stems one to many; plants 1-3 ft. tall; biennial or 
short-lived perennial.  
 

Asteraceae (Aster Family) 
 

Synonym:  Acosta maculosa 
Look alikes: Spotted knapweed can be distinguished from other 
knapweeds by the dark tips and fringed margins on the floral bracts.   
Spotted knapweed may resemble native members of the sunflower family 
in the seedling/rosette stage. 
Flowering/Fruiting Period: June-October. 
Distribution: Native to central Europe; introduced and becoming 
widespread throughout the western United States.  It is increasing 
throughout Colorado. 

 



Habitat: Roadsides, rangeland, dry meadows, gravelly floodplains, and 
other disturbed areas.  Elevation 4000-6000 ft. 
References: CNAP 2000; Cronquist et al. 1994; Hitchcock et al. 1969; 
Whitson et al. 2000; Zimdahl 1998. 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
          Spotted knapweed plant and rosette courtesy of Weeds of the West  
 
 
 
 
 
 
 
 
 
 
 
 
  
 

 

 



COLORADO NOXIOUS WEED 
 
YELLOW STARTHISTLE                  Centaurea solstitialis 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Identifying characteristics:  Flowers solitary, yellow heads 
approximately 1.5 inches wide and 1 inch long, occurring on the ends of 
branches with 0.75-1 inch long, stiff, straw colored thorns extending from 
the flower’s seed case; leaves alternate, 2-3 inches in length with white 
cottony hairs, upper leaves entire, thin and pointy, basal leaves larger and 
deeply lobed; stems erect, up to 2-3 ft. tall, winged, with white cottony 
hairs and rigid branching from base and above; annual.    

 
Asteraceae (Aster Family) 

 
Look alikes: Several other Centaurea species are similar. C . calcitrapa 
(purple starthistle) and  C. iberica (Iberian starthistle) are similar but have 
not been found in Colorado. C . melitensis (Malta starthistle) occurs in 
Colorado, but has smaller seed heads and spines which branch at the base. 
Flowering/Fruiting Period: July -September. 
Distribution: Native to the Mediterranean region; introduced from Europe 
and found in much of the United States. Found occasionally along the  
Colorado Front Range and West Slope. Elevation 5000-6500 ft. 

 



Habitat: Rangelands, pastures, cropland, roadsides, and waste areas. 
Favors sunny dry-land conditions. 
References: CNAP 2000; Cronquist et al. 1994; Whiston 2000; Zimdahl 
1998. 
 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

               
                
 
 
 Yellow starthistle plant and rosette courtesy of Weeds of the West  
 
 
 
 
 
 
 
 
 

 

 



COLORADO NOXIOUS WEED 
 
YELLOW  TOADFLAX                           Linaria vulgaris 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Identifying characteristics:  Flowers yellow with a bearded orange throat, 
resembling snapdragons, occurring in terminal, elongated racemes; leaves 
are alternate, pale green, soft, narrow, and lance shaped; stems are smooth, 
erect, 1-25 per plant, clumps of stems 1- 3 ft. tall; perennial.  
 

Scrophulariaceae (Figwort Family) 
 
Look alikes: The exotic dalmation toadflax (Linaria dalmatica) is similar 
in appearance and can be distinguished by its broad, rounded leaves that 
clasp the stem. 
Flowering/Fruiting Period: May-October. 
Distribution: Native to Eurasia; introduced and naturalized throughout 
temperate North America, more common in the eastern states. Locally 
common in scattered locations throughout Colorado, mainly on the 
Western Slope. 
Habitat: Roadsides, rangelands, cultivated fields and waste areas.  
Elevation 6000-8500 ft., occasionally up to 10,000 ft. 
 

                  



 
 
References: CNAP 2000; CNHP 2002;  Cronquist et al. 1994; CWMA 
2002; Hitchcock et al. 1969; Whitson et al. 2000; Zimdahl 1998. 
 

                      

 
Yellow toadflax by David G. Anderson 

                  

      
       Vegetative yellow toadflax courtesy  
        of Weeds of the West  



__________________________________________________ 
GLOSSARY 
    
Adventitious - Arising elsewhere, occurring in an unusual or unexpected 
place. 
Alternate - Borne singly, not opposite. 
Annual - A plant with a one-year life cycle, from seed to seed in one 
growing season. 
Basal - Leaves produced at ground level. 
Bearded - Flowers that have a tuft of long hairs. 
Biennial - A plant that lives for two growing seasons, usually flowering 
only in the second year. 
Bract - Reduced or modified leaf found below a flower. 
Branchlet - A small, usually terminal branch.  
Clasping - Leaf base partly or entirely surrounding the stem. 
Diffuse - Scattered. 
Elliptical - Oval or oblong with rounded ends; widest in the center and the 
two ends equal. 
Entire - Leaf margins that are not cut or toothed. 
Erect - Upright in relation to the ground. 
Lanceolate  - Lance-shaped; several times longer than wide. 
Lobe - A division or segment of a structure usually rounded in outline. 
Lobed - Having lobes. 
Margin - An edge, as in the edge of a leaf blade. 
Ovate, Ovoid - Egg-shaped with the broadest end toward the base. 
Perennial - A plant that lives for three or more years. 
Pinnate - A compound leaf with the leaflets on two opposite sides of an 
elongated axis. 
Prostrate  - A plant that lies flat on the ground. 
Raceme  - Arrangement of flowers along a stem on individual stalks about 
equal in length. 
Rhizomatous  - Having rhizomes. 
Rhizome  - Underground stem, growing horizontally, sending out shoots 
above ground and roots below. 
Rib - Prominently raised vein or wing-like structure. 
Rosette  - Compact cluster of leaves located at, or near the ground at the 
base of a stem.  
Serrate  - With sharp teeth pointed forward. 
Solitary - Occurring singly, not as a part of a group or cluster. 
Terminal - At the top or end. 
Throat - The narrow or constricted opening of a flower. 
Winter annual  - A plant with seeds that germinate in the fall and complete 
growth in spring of the next season. 
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First Pass Noxious Weeds  
Canada Thistle 
Dalmation Toadflax 
Diffuse Knapweed 
Field Bindweed 
Hoary Cress 
Houndstounge 
Jointed Goatgrass 
Leafy Spurge 
Musk Thistle 
Perennial Pepperweed 
Russian Knapweed 
Spotted Knapweed 
Yellow Toadflax 
 
New Noxious Weeds (discontinued) 
African Rue 
Camelthorne 
Lespedeza 
Orange Hawkweed 
Yellow Starthistle 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Second Pass Noxious Weeds  
Black henbane 
Bull thistle 
Canada thistle 
Chinese clematis 
Dalmatian toadflax 
Dame's rocket 
Diffuse knapweed 
Field bindweed 
Hoary cress 
Houndstounge 
Jointed goatgrass 
Leafy spurge 
Musk thistle 
Orange hawkweed 
Oxeye daisy 
Perennial pepperweed 
Plumeless thistle 
Purple loosestrife 
Russian knapweed 
Russian-olive 
Saltcedar 
Scotch thistle 
Spotted knapweed 
Yellow starthistle 
Yellow toadflax 
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Roads Metadata 
February, 2004 
 
 
Roads## Shapefile Metadata 
 
Shapefile Name:  Roads## 
 
Source of Data:  Features in the Roads## shapefile were originally collected using Trimble 
GeoExplorer3 global positioning system (GPS) units.  The GPS units were configured for zero-to-
five meter spatial accuracy after differential correction.  The data collected were quality checked, 
processed, and exported to a shapefile using Trimble’s Pathfinder Office 2.51 software.  The 
multiple shapefiles created from the multiple GPS files were then merged into a single shapefile 
using the XTOOLS ArcView extension. 
 
Description:  The linear features of the Roads## shapefile are representative of the center of the 
road surface for CDOT maintained roadways.  Roadways separated by a vegetated median 
(including ramps and frontage roads) were mapped in all necessary directions as to identify the 
location of the median. 
 
Dates of Data Collection:  Data collection began August 23, 2000 and is ongoing. 
 
Projection Information: 
Datum:  NAD83 
Projection:  UTM 
Zone:  13 
Units:  Meters 
 
Attributes: 

1) Shape (Width – 9)(Type – Character) – ESRI software assigned variable.  Is “Polyline” for 
all GIS line shapes. 

 
2) Collector (Width - 30) (Type – Character) – The name of the individual who collected the 

data with the GPS unit in the field. 
 
3) Date (Width – 8) (Type – Date) – Date data was collected in the field. 
 
4) Section (Width – 20) (Type – Character) – CDOT Maintenance Section number. 

 
5) Patrol (Width – 2) (Type – Numeric (0 Decimal)) – CDOT Maintenance Patrol within 

CDOT Maintenance Section. 
 
6) Route (Width – 4) (Type – Character) – Name of highway by route and log letter. 

 
7) Road_Type (Width – 20) (Type – Character) – Broad description of highway.  Required in 

GPS data dictionary to select either Main_Hwy, Frontage_Road, or Ramp.  A Road_Type 
of Ramp is used for roads through CDOT maintained rest areas. 

 
8) Ref_Pt (Width – 7) (Type – Numeric (3 Decimal)) – Highway mile marker where patrol or 

road segment begins.  For roadways with a Road_Type of Main_Hwy, this information is 
derived from the Log of Patrols (although the roadway may be segmented due to satellite 
reception problems of the GPS units).  For roadways with the Road_Type of 
Frontage_Road or Ramp, this information is based on either the Log of Patrols (where 
data exists), was approximated during data collection, or was approximated using the 
measuring tool in Pathfinder Office from a known location (i.e. existing mile marker). 
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9) Endref_pt (Width – 7) (Type – Numeric (3 Decimal)) – Highway mile marker where patrol 
or road segment ends.  For roadways with a Road_Type of Main_Hwy, this information is 
derived from the Log of Patrols (although the roadway may be segmented due to satellite 
reception problems of the GPS units).  For roadways with the Road_Type of 
Frontage_Road or Ramp, this information is based on either the Log of Patrols (where 
data exists), was approximated during data collection, or was approximated using the 
measuring tool in Pathfinder Office from a known location (i.e. existing mile marker).  This 
attribute is not required for ramps and frontage roads, although a null value is not 
permissible.  In cases when this field is not required and was not used by the person 
doing the data collection, 0.00 will be in this field. 

 
10) Comments (Width – 100) (Type – Character) – Used for any comments/information on 

the data deemed necessary by the person collecting the data, but not accommodated by 
the data dictionary. 

 
11) Sourcethm (Width – 16) (Type – Character) – Left over Xtools attribute.  May be deleted 

if it is still in the data. 
 

12)  Datafile (Width – 20) (Type – Character) - Name of the Pathfinder Office file that was 
exported to create the shapefile.  This field was created 10/29/00.  If it is blank, the data 
was processed before the creation of this field. 

 
13) Length_Meters (Width – 16) (Type – Numeric (3 Decimal)) Length in meters of the line 

segment. 
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Mile Marker Metadata 
February, 2004 
 
 
MM## Shapefile Metadata 
 
Shapefile Name:  MM## 
 
Source of Data:  Features in the MM## shapefile were originally collected using Trimble 
GeoExplorer3 global positioning system (GPS) units.  The GPS units were configured for zero-to-
five meter spatial accuracy after differential correction.  The data collected were quality checked, 
processed, and exported to a shapefile using Trimble’s Pathfinder Office 2.51 software.  The 
multiple shapefiles created from the multiple GPS files were then merged into a single shapefile 
using the XTOOLS ArcView extension. 
 
Description:  The point features of the MM## shapefile are representative of the physical 
location of mile marker posts on CDOT maintained roadways.  “Imaginary” mile markers were 
collected to represent the location of a change Patrol along a roadway.  Any mile marker feature 
with the Ref_Pt attribute that is not a whole number is an imaginary mile marker and does not 
exist in any physical form on the ground. 
 
Dates of Data Collection:  Data collection began August 23, 2000 and is ongoing. 
 
Projection Information: 
Datum:  NAD83 
Projection:  UTM 
Zone:  13 
Units:  Meters 
 
Attributes: 

14) Shape (Width – 9)(Type – Character) – ESRI software assigned variable.  Is “Point” for all 
GIS point shapes. 

 
15) Collector (Width - 30) (Type – Character) – The name of the individual who collected the 

data with the GPS unit in the field. 
 

16) Date_ (Width – 8) (Type – Date) – Date data was collected in the field. 
 

17) Section (Width – 20) (Type – Character) – CDOT Maintenance Section number. 
 

18) Patrol (Width – 2) (Type – Numeric (0 Decimal)) – CDOT Maintenance Patrol within 
CDOT Maintenance Section. 

 
19) Route (Width – 4) (Type – Character) – Name of highway by route and log letter along 

which the mile markers are mapped. 
 

20) Road_type (Width – 20) (Type – Character) – Broad description of highway.  Required in 
GPS data dictionary to select either Main_Hwy, Frontage_Road, or Ramp. 

 
21) Ref_pt (Width – 7) (Type – Numeric (3 Decimal)) – Number of the mapped mile marker.  

Mile markers with a non-whole number Ref_Pt are imaginary mile markers signifying the 
beginning or end of a patrol. 
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22) Comments (Width – 100) (Type – Character) –Used for any comments/information on the 
data deemed necessary by the person collecting the data, but not accommodated by the 
data dictionary. 

23) Sourcethm (Width – 16) (Type – Character) – Left over Xtools attribute.  May be deleted 
if it is still in the data. 

 
24)  Datafile (Width – 20) (Type – Character) - Name of the Pathfinder Office file that was 

exported to create the shapefile.  This field was created 10/29/00.  If it is blank, the data 
was processed before the creation of this field. 
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Maintenance Yards Metadata 
February, 2004 
 
 
Mainyd## Shapefile Metadata 
 
Shapefile Name:  Mainyd## 
 
Source of Data:  Features in the Mainyd## shapefile were originally collected using Trimble 
GeoExplorer3 global positioning system (GPS) units.  The GPS units were configured for zero-to-
five meter spatial accuracy after differential correction.  The data collected were quality checked, 
processed, and exported to a shapefile using Trimble’s Pathfinder Office 2.51 software.  The 
multiple shapefiles created from the multiple GPS files were then merged into a single shapefile 
using the XTOOLS ArcView extension. 
 
Description:  The polygonal features of the Mainyd## shapefile represent the fence-line of a 
CDOT maintenance yard or the boundary of a CDOT maintained rest area.   
 
Dates of Data Collection:  Data collection began August 23, 2000 and is ongoing. 
 
Projection Information: 
Datum:  NAD83 
Projection:  UTM 
Zone:  13 
Units:  Meters 
 
Attributes: 

25) Shape (Width – 9)(Type – Character) – ESRI software assigned variable.  Is “Polygon” 
for all GIS polygon shapes. 

 
26) Collector (Width - 20) (Type – Character) – The name of the individual who collected the 

data with the GPS unit in the field. 
 

27) Date_ (Width – 8) (Type – Date) – Date data was collected in the field. 
 

28) Section (Width – 20) (Type – Character) – CDOT Maintenance Section number. 
 

29) Patrol (Width – 2) (Type – Numeric (0 Decimal)) – CDOT Maintenance Patrol within 
CDOT Maintenance Section. 

 
30) Route (Width – 4) (Type – Character) – Name of highway by route and log letter along 

which the weeds are located. 
 

31) Ref_pt (Width – 7) (Type – Numeric (3 Decimal)) – Reference point associated with the 
maintenance yard or the rest area (usually related to the highway where the facility is 
located). 

 
32) Yard_name (Width – 30) (Type – Character) – Generic name given to the maintenance 

yard or rest area. 
 

33) Comments (Width – 100) (Type – Character) – This field was used for any 
comments/information on the data deemed necessary by the person collecting the data, 
but not accommodated by the data dictionary. 
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34) Datafile (Width – 20) (Type – Character) - Name of the Pathfinder Office file that was 
exported to create the shapefile.  This field was created 10/29/00.  If it is blank, the data 
was processed before the creation of this field. 

 
35) Sourcethm (Width – 16) (Type – Character) – Left over Xtools attribute.  May be deleted 

if it is still in the data. 
 

36) Area (Width – 16) (Type – Numeric (3 Decimal)) – Area of the polygon in square meters. 
 

37) Perimeter_meters (Width – 16) (Type – Numeric (3 Decimal)) – Distance of the perimeter 
of the polygon in meters. 
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Noxious Weed Metadata 
February, 2004 
 
Noxious Weed Information/Data Includes: 
 

1) Noxious Weed Data Disclaimer 
 

2) Noxious Weed Metadata (1st round) 
 

3) Noxious Weed Metadata (2nd round) 
 
 
Noxious Weed Data Disclaimer 
 
The information provided should not replace field studies necessary for more localized planning efforts. 
Please note that the absence of any data does not mean that other resources of special concern do not occur, 
but rather our files do not currently contain information to document this presence. 
  
The data contained herein are provided on an as-is, as-available basis without warranties of any kind, 
expressed or implied, including (but not limited to) warranties of merchantability, fitness for a particular 
purpose, and non-infringement. The Colorado Department of Transportation (CDOT), further expressly 
disclaim any warranty that the data are error-free or current as of the date supplied. 
 
Noxious Weeds Metadata 
 
CDOT Noxious Weed information is represented by four GIS themes.  WEEDLINES is a theme 
representing the noxious weed occurrences linearly along the state highway system.  WEEDBUFS is a 
theme representing a right of way buffer of these weed locations.  WEEDLINES and WEEDBUFS 
represent the first pass of noxious weed data collection (i.e. the original collection of noxious weed data).  
2pwdli## (or whatever the file will be named prior to posting for public access) is a 
theme representing a second pass of weed data collection to monitor changes in weed 
locations over time.  2pwdli## represents the noxious weed occurrences linearly along 
the state highway system.  2pwdbu## (or whatever the file will be named prior to posting 
for public access) is a theme representing a right of way buffer of the weed locations 
found in 2pwdli##. 
 
  
Source of Data:  Features in the WEEDLINES and 2pwdli## theme were originally collected using 
Trimble GeoExplorer3 global positioning system (GPS) units.  The GPS units were configured for zero-to-
five meter spatial accuracy after differential correction.  The data collected were quality checked, 
processed, and exported to a shapefile using Trimble’s Pathfinder Office 2.51 or 2.80 software.  All of the 
shapefiles were created from the multiple GPS files and then merged into a single shapefile using the 
XTOOLS ArcView (non-CDOT) extension. 
  
Description:   The polygonal features of the WEEDBUFS theme represent buffered data from the 
WEEDLINES theme.  This data was buffered by half of the distance of the ROW_width_in_feet attribute 
from the WEEDBUFS theme.  The data in the WEEDLINES theme represents the center of the vegetated 
area between the edge of a CDOT ma intained highway and the outer boundary of the CDOT right-of-way 
where existing noxious weeds are growing.  The location could also be in the center of a vegetated median.  
Hence, the polygonal features contained in the WEEDBUFS theme represent a vegetated area on CDOT 
maintained land that has noxious weeds growing on it. 
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The polygonal features of the 2pwdbu## theme represent buffered data from the 2pwdli## theme.  This 
data was buffered by half of the distance of the ROW_width_in_feet attribute from the 2pwdbu## theme.  
The data in the 2pwdli## theme represents the center of the vegetated area between the edge of a CDOT 
maintained highway and the outer boundary of the CDOT right-of-way where existing noxious weeds are 
growing.  The location could also be in the center of a vegetated median.  Hence, the polygonal features 
contained in the 2pwdbu## theme represent a vegetated area on CDOT maintained land that has noxious 
weeds growing on it. 
 
WEEDLINES and WEEDBUFS Shapefile Metadata 
 
Dates of Data Collection:  Data collection began August 23, 2000 and is ongoing. 
  
Projection Information: 
Datum:  NAD83 
Projection:  UTM 
Zone:  13 
Units:  Meters 
 
WEEDLINES Shapefile Metadata (1st Round) 
 
Attributes:  
 

1) Shape (Width – 9)(Type – Character) – ESRI software assigned variable.  Is “Polyline” for all GIS 
line shapes. 

 
2) Collector (Width - 30) (Type – Character) – The name of the individual who collected the data 

with the GPS unit in the field. 
 

3) Date_ (Width – 8) (Type – Date) – Date data was collected in the field.  Format - yyyymmdd 
 

4) Section (Width – 20) (Type – Character) – CDOT Maintenance Section number. 
 

5) Patrol (Width – 2) (Type – Numeric (0 Decimal)) – CDOT Maintenance Patrol within CDOT 
Maintenance Section. 

 
6) Route (Width – 4) (Type – Character) – Name of highway by route and log letter along which the 

weeds were located. 
 

7) Row_width_ (Width – 3) (Type – Numeric (0 Decimal) – The width in feet of the vegetated area 
where the weeds were growing. 

 
8) Primary_wd (Width – 20) (Type – Character) - Name of the primary (dominant) type of existing 

noxious weed that was growing in the mapped area. 
 

9) Pw_cover_ (Width – 20) (Type – Character) – Percentage of the mapped area that was covered by 
the primary weed (Primary_wd), noting that the line feature will later be converted to a polygon. 

 
10) Pw_contain (Width – 20) (Type – Character) – If the primary weed (Primary_wd) was growing 

only on the CDOT right-of-way, this field will state “Yes”; if the primaryweed (Primary_wd) was 
growing on the CDOT right-of-way and also outside of the CDOT right-of-way, his field will state 
“No”. If the collector is unsure if the primary weed was “contained” on the CDOT right-of-way or 
not, this field will state “Unsure”. 

 
11) Second_wd (Width – 20) (Type – Character) – Name of the secondary (second most dominant) 

type of existing noxious weed that was growing in the mapped area. 
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12) Sw_cover – (Width – 20) (Type – Character) Percentage of the mapped area that was covered by 
the secondary weed (Second_wd). 

 
13) Sw_contain – (Width – 20) (Type – Character) If the Secondary weed (Second_wd) was growing 

only on the CDOT right-of-way, this field will state “Yes”; if the secondary weed (Secondary_wd) 
was growing on the CDOT right-of-way and also outside of the CDOT right-of-way, this field will 
state “No”. If the collector was unsure if the primary weed was “contained” on the CDOT right-of-
way or not, this field will state “Unsure”. 

 
14) Comments (Width – 100) (Type – Character) – Used for any comments/information on the data 

deemed necessary by the person collecting the data in the field or by someone during the post 
processing of the data. 

 
15) Sourcethm (Width – 16) (Type – Character) – Left over processing attribute.  May be deleted if it 

is still in the data. 
 

16) Buffdist (Width – 8) (Type – Numeric (3 Decimal)) – Distance the WEEDLI NES linear theme 
was buffered by to create the polygonal WEEDBUFS theme. 

 
17) Datafile (Width – 20) (Type – Character) - Name of the Pathfinder Office file that was exported to 

create the theme. This field was created 10/29/00. If it is blank, the data was processed before the 
creation of this field. 

 
18) Length (Width – 16) (Type – Numeric (3 Decimal)) Length in feet of the line segment. 

 
WEEDBUFS Shapefile Metadata (1st Round) 
 

1) Shape (Width – 9)(Type – Character) – ESRI software assigned variable.  Is “Polygon” for all GIS 
polygon shapes. 

 
2) Buff_id (Width – 11) (Type – Numeric (0 Decimal)) – Field in the WEEDBUFS theme created by 

XTOOLS buffer command to numerically identify the various line features being buffered. This 
field can be deleted from the table. It has no significance to this dataset. 

 
3) Buff_dist (Width – 12) (Type – Numeric (5 Decimal)) – Distance the WEEDLINES linear theme 

was buffered to create the polygonal WEEDBUFS theme. 
 

4) Buff_area (Width –12) (Type – Numeric (5 Decimal)) – Area in square feet of the WEEDBUFS 
polygons. 

 
5) Collector (Width - 30) (Type – Character) – The name of the individual who collected the data 

with the GPS unit in the field. 
 

6) Date_ (Width – 8) (Type – Date) – Date data was collected in the field.  Format – yyyymmdd 
 

7) Section (Width – 20) (Type – Character) – CDOT Maintenance Section number. 
 

8) Patrol (Width – 2) (Type – Numeric (0 Decimal)) – CDOT Maintenance Patrol within CDOT 
Maintenance Section. 

 
9) Route (Width – 4) (Type – Character) – Name of highway by route and log letter along wh ich the 

weeds were located. 
 

10) Row_width_ (Width – 3) (Type – Numeric (0 Decimal) – The width in feet of the vegetated area 
where the weeds were growing. 
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11) Primary_wd (Width – 20) (Type – Character) - Name of the primary (dominant) type of existing 
noxious weed that was growing in the mapped area. 

 
12) Pw_cover_ (Width – 20) (Type – Character) – Percentage of the mapped area that was covered by 

the primary weed (Primary_wd), noting that the line feature will later be converted to a polygon. 
 

13) Pw_contain (Width – 20) (Type – Character) – If the primary weed (Primary_wd) was growing 
only on the CDOT right-of-way, this field will state “Yes”; if the primaryweed (Primary_wd) was 
growing on the CDOT right-of-way and also outside of the CDOT right-of-way, his field will state 
“No”. If the collector is unsure if the primary weed was “contained” on the CDOT right-of-way or 
not, this field will state “Unsure”. 

 
14) Second_wd (Width – 20) (Type – Character) – Name of the secondary (second most dominant) 

type of existing noxious weed that was growing in the mapped area. 
 

15) Sw_cover – (Width – 20) (Type – Character) Percentage of the mapped area that was covered by 
the secondary weed (Second_wd). 

 
16) Sw_contain – (Width – 20) (Type – Character) If the Secondary weed (Second_wd) was growing 

only on the CDOT right-of-way, this field will state “Yes”; if the secondary weed (Secondary_wd) 
was growing on the CDOT right-of-way and also outside of the CDOT right-of-way, this field will 
state “No”. If the collector was unsure if the primary weed was “contained” on the CDOT right-of-
way or not, this field will state “Unsure”. 

 
17) Comments (Width – 100) (Type – Character) – Used for any comments/information on the data 

deemed necessary by the person collecting the data in the field or by someone during the post 
processing of the data. 

 
18) Sourcethm (Width – 16) (Type – Character) – Left over processing attribute.  May be deleted if it 

is still in the data. 
 

19) Buffdist (Width – 8) (Type – Numeric (3 Decimal)) – Distance the WEEDLINES linear theme 
was buffered by to create the polygonal WEEDBUFS theme. 

 
20) Datafile (Width – 20) (Type – Character) - Name of the Pathfinder Office file that was exported to 

create the theme. This field was created 10/29/00. If it is blank, the data was processed before the 
creation of this field. 

 
21) Area (Width – 16) (Type – Numeric (3 Decimal)) – Area of the polygon in square meters. 

 
22) Perimeter (Width – 16) (Type – Numeric (3 Decimal)) – Distance of the perimeter of the polygon 

in meters. 
 
2pwdli## Shapefile Metadata (2nd Round) 
 
Shapefile Name:  2pwdli## 
 
Source of Data:  Features in the 2pwdli## shapefile were originally collected using Trimble GeoExplorer3 
global positioning system (GPS) units.  The GPS units were configured for zero-to-five meter spatial 
accuracy after differential correction.  The data collected were quality checked, processed, and exported to 
a shapefile using Trimble’s Pathfinder Office software.  The multiple shapefiles created from the multiple 
GPS files were then merged into a single shapefile using the XTOOLS ArcView extension. 
 
Description:   The data in 2pwdli## represents a second pass of mapping noxious weeds for vegetated areas 
on CDOT rights-of-way.  First pass data can be found in the Exwdli## shapefile.  The linear features of the 
2pwdli## shapefile represent the center of the vegetated area between the edge of a CDOT maintained 
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highway and the outer boundary of the CDOT right-of-way where existing noxious weeds are growing.  
The location could also be in the center of a vegetated median. 
 
Dates of Data Collection:  Data collection began August 1, 2002 and is ongoing. 
 
 
 
 
 
Projection Information: 
Datum:  NAD83 
Projection:  UTM 
Zone:  13 
Units:  Meters 
 
Attributes: 

1) Shape (Width – 9)(Type – Character) – ESRI software assigned variable.  Is “Polyline” for all GIS 
line shapes. 

 
2) Collector (Width - 30) (Type – Character) – Name of the individual who collected the data with 

the GPS unit in the field. 
 

3) Date_ (Width – 8) (Type – Date) – Date data was collected in the field. 
 

4) Section (Width – 20) (Type – Character) – CDOT Maintenance Section number. 
 

5) Patrol (Width – 2) (Type – Numeric (0 Decimal)) – CDOT Maintenance Patrol within CDOT 
Maintenance Section. 

 
6) Route (Width – 4) (Type – Character) – Name of highway by route and log letter along which the 

weeds were located. 
 

7) Row_width_in_feet (Width – 3) (Type – Numeric (0 Decimal) – The width in feet of the vegetated 
area where the weeds were growing. 

 
8) Primary_wd (Width – 20) (Type – Character) - Name of the primary (dominant) type of existing 

noxious weed that was growing in the area being mapped. 
 

9) Pw_cover_ (Width – 20) (Type – Character) – Percentage of the mapped area that was covered by 
the primary weed (Primary_wd), noting that the line feature will later be converted to a polygon. 

 
10) Pw_contain (Width – 20) (Type – Character) – If the primary weed (Primary_wd) was growing 

only on the CDOT right-of-way, this field will state “Yes”; if the primary weed (Primary_wd) was 
growing on the CDOT right-of-way and also outside of the CDOT right-of-way, this field will 
state “No”.  If the collector was unsure if the primary weed is “contained” on the CDOT right-of-
way or not, this field will state “Unsure”. 

 
11) Second_wd (Width – 20) (Type – Character) – Name of the secondary (second most dominant) 

type of existing noxious weed that was growing in the mapped area. 
 

12) Sw_cover – (Width – 20) (Type – Character) Percentage of the mapped area that was covered by 
the secondary weed (Second_wd), noting that the line feature will later be converted to a polygon. 

 
13) Sw_contain – (Width – 20) (Type – Character) If the Secondary weed (Second_wd) was growing 

only on the CDOT right-of-way, this field will state “Yes”; if the secondary weed (Secondary_wd) 
was growing on the CDOT right-of-way and also outside of the CDOT right-of-way, this field will 
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state “No”.  If the collector was unsure if the primary weed is “contained” on the CDOT right-of-
way or not, this field will state “Unsure”. 

 
14) Comments (Width – 100) (Type – Character) – Used for any comments/information on the data 

deemed necessary by the person collecting the data, but not accommodated by the data dictionary. 
 

15) Sourcethm (Width – 16) (Type – Character) – Left over Xtools attribute.  May be deleted if it is 
still in the data. 

 
16) Buffdist (Width – 8) (Type – Numeric (3 Decimal)) – Distance the line feature will be buffered by 

to create the polygonal Exwdbu## shapefile.  This distance equals half of the Row_width_in_feet.  
Units are in feet. 

 
17) Datafile (Width – 20) (Type – Character) - Name of the Pathfinder Office file that was exported to 

create the shapefile.  This field was created 10/29/00.  If it is blank, the data was processed before 
the creation of this field. 

 
18) Length_Feet (Width – 16) (Type – Numeric (3 Decimal)) Length in feet of the line segment. 

 
2pwdbu## Shapefile Metadata 
 

Shapefile Name:  2pwdbu## 
 

Source of Data:  Features in the 2pwdbu## shapefile were originally collected using Trimble 
GeoExplorer3 global positioning system (GPS) units.  The GPS units were configured for zero-to-five 
meter spatial accuracy after differential correction.  The data collected were quality checked, 
processed, and exported to a shapefile using Trimble’s Pathfinder Office 2.51 or 2.80 software.  The 
multiple shapefiles created from the multiple GPS files were then merged into a single shapefile using 
the XTOOLS ArcView extension. 

 
Description:   The data in 2pwdbu## represents a second pass of mapping noxious weeds for vegetated 
areas on CDOT rights-of-way.  First pass data can be found in the Exwdbu## shapefile.  The polygonal 
features of the 2pwdbu## shapefile represent buffered data from the 2pwdli## shapefile.  This data was 
buffered by half of the distance of the ROW_width_in_feet attribute from the 2pwdli## shapefile.  The 
data in the 2pwdli## shapefile represented the center of the vegetated area between the edge of a 
CDOT maintained highway and the outer boundary of the CDOT right-of-way where existing noxious 
weeds are growing.  The location could also be in the center of a vegetated median.  Hence, the 
polygonal features contained in the 2pwdbu## represent a vegetated area on CDOT maintained land 
that has noxious weeds growing on it. 

 
Dates of Data Collection:  Data collection began August 1, 2002 and is ongoing. 

 
Projection Information: 
Datum:  NAD83 
Projection:  UTM 
Zone:  13 
Units:  Meters 

 
Attributes: 
1) Shape (Width – 9)(Type – Character) – ESRI software assigned variable.  Is “Polyline” for all GIS 

line shapes. 
 

2) Buff_id (Width – 11) (Type – Numeric (0 Decimal)) – Field created by XTOOLS buffer command 
to numerically identify the various line features being buffered.  This field can be deleted from the 
table.  It has no significance to this dataset. 
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3) Buff_dist (Width – 12) (Type – Numeric (5 Decimal)) – Distance the 2pwdli## linear shapefile 
was buffered by to create the polygonal 2pwdbu## shapefile. 

 
4) Buff_area (Width –12) (Type – Numeric (5 Decimal)) – Area in square feet of the polygon. 

 
5) Collector (Width - 30) (Type – Character) – The name of the individual who collected the data 

with the GPS unit in the field. 
 

6) Date_ (Width – 8) (Type – Date) – Date data was collected in the field. 
 
7) Section (Width – 20) (Type – Character) – CDOT Maintenance Section number. 

 
8) Patrol (Width – 2) (Type – Numeric (0 Decimal)) – CDOT Maintenance Patrol within CDOT 

Maintenance Section. 
 

9) Route (Width – 4) (Type – Character) – Name of highway by route and log letter along which the 
weeds were located. 

 
10) Row_width_in_feet (Width – 3) (Type – Numeric (0 Decimal) – The width in feet of the vegetated 

area where the weeds were growing. 
 

11) Primary_wd (Width – 20) (Type – Character) - Name of the primary (dominant) type of existing 
noxious weed that was growing in the mapped area. 

   
12) Pw_cover_ (Width – 20) (Type – Character) – Percentage of the mapped area that was covered by 

the primary weed (Primary_wd), noting that the line feature will later be converted to a polygon. 
 

13) Pw_contain (Width – 20) (Type – Character) – If the primary weed (Primary_wd) was growing 
only on the CDOT right-of-way, this field will state “Yes”; if the primary weed (Primary_wd) was 
growing on the CDOT right-of-way and also outside of the CDOT right-of-way, this field will 
state “No”.  If the collector is unsure if the primary weed was “contained” on the CDOT right-of-
way or not, this field will state “Unsure”. 

 
14) Second_wd (Width – 20) (Type – Character) – Name of the secondary (second most dominant) 

type of existing noxious weed that was growing in the mapped area. 
 

15) Sw_cover – (Width – 20) (Type – Character) Percentage of the mapped area that was covered by 
the secondary weed (Second_wd). 

 
16) Sw_contain – (Width – 20) (Type – Character) If the Secondary weed (Second_wd) was growing 

only on the CDOT right-of-way, this field will state “Yes”; if the secondary weed (Secondary_wd) 
was growing on the CDOT right-of-way and also outside of the CDOT right-of-way, this field will 
state “No”.  If the collector was unsure if the primary weed was “contained” on the CDOT right-
of-way or not, this field will state “Unsure”. 

 
17) Comments (Width – 100) (Type – Character) – Used for any comments/information on the data 

deemed necessary by the person collecting the data in the field or by someone during the post 
processing of the data. 

 
18) Sourcethm (Width – 16) (Type – Character) – Left over Xtools attribute.  May be deleted if it is 

still in the data. 
 

19) Buffdist (Width – 8) (Type – Numeric (3 Decimal)) – Distance the 2pwdli## linear shapefile was 
buffered by to create the polygonal 2pwdbu## shapefile. 

 
20) Hectares (Width – 16) (Type – Numeric (3 Decimal)) – Area of the polygon in hectares. 
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21) Datafile (Width – 20) (Type – Character) - Name of the Pathfinder Office file that was exported to 

create the shapefile.  This field was created 10/29/00.  If it is blank, the data was processed before 
the creation of this field. 

 
22) Acres (Width – 16) (Type – Numeric (3 Decimal)) – Area of the polygon in acres. 

 
23) Area_meters (Width – 16) (Type – Numeric (3 Decimal)) – Area of the polygon in square meters. 

 
24) Perimeter_meters (Width – 16) (Type – Numeric (3 Decimal)) – Distance of the 

perimeter of the polygon in meters. 
 
 


